
A Random Variables
and Probability Distributions

A.1 Distribution Functions and Expectation
A.2 Random Vectors
A.3 The Multivariate Normal Distribution

A.1 Distribution Functions and Expectation

The distribution function F of a random variable X is defined by

F(x) = P[X ≤ x] (A.1.1)

for all real x. The following properties are direct consequences of (A.1.1):

1. F is nondecreasing, i.e., F(x) ≤ F(y) if x ≤ y.
2. F is right continuous, i.e., F(y) ↓ F(x) as y ↓ x.
3. F(x) → 1 and F(y) → 0 as x → ∞ and y → −∞, respectively.

Conversely, any function that satisfies properties 1–3 is the distribution function of
some random variable.

Most of the commonly encountered distribution functions F can be expressed
either as

F(x) =
∫ x

−∞
f (y)dy (A.1.2)

or

F(x) =
∑
j:xj≤x

p(xj), (A.1.3)

where {x0, x1, x2, . . .} is a finite or countably infinite set. In the case (A.1.2) we shall
say that the random variable X is continuous. The function f is called the probability
density function (pdf) of X and can be found from the relation

f (x) = F′(x).
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354 Appendix A Random Variables and Probability Distributions

In case (A.1.3), the possible values of X are restricted to the set {x0, x1, . . .}, and we
shall say that the random variable X is discrete. The function p is called the probability
mass function (pmf) of X, and F is constant except for upward jumps of size p(xj) at
the points xj. Thus p(xj) is the size of the jump in F at xj, i.e.,

p(xj) = F(xj) − F(x−
j ) = P[X = xj],

where F(x−
j ) = limy↑xj F(y).

A.1.1 Examples of Continuous Distributions

(a) The normal distribution with mean μ and variance σ 2. We say that a random
variable X has the normal distribution with mean μ and variance σ 2

(
written more

concisely as X ∼ N
(
μ, σ 2

))
if X has the pdf given by

n
(
x;μ, σ 2) = (2π)−1/2σ−1e−(x−μ)2/(2σ 2) − ∞ < x < ∞.

It follows then that Z = (X − μ)/σ ∼ N(0, 1) and that

P[X ≤ x] = P

[
Z ≤ x − μ

σ

]
= �

(
x − μ

σ

)
,

where �(x)= ∫ x
−∞(2π)−1/2e− 1

2 z
2
dz is known as the standard normal distribu-

tion function. The significance of the termsmean and variance for the parameters
μ and σ 2 is explained below (see Example A.1.1).

(b) The uniform distribution on [a, b]. The pdf of a random variable uniformly dis-
tributed on the interval [a, b] is given by

u(x; a, b) =

⎧⎪⎨
⎪⎩

1

b − a
, if a ≤ x ≤ b,

0, otherwise.

(c) The exponential distribution with parameter λ. The pdf of an exponentially dis-
tributed random variable with parameter λ > 0 is

e(x;λ) =
⎧⎨
⎩

0, if x < 0,

λe−λx, if x ≥ 0.

The corresponding distribution function is

F(x) =
{

0, if x < 0,

1 − e−λx, if x ≥ 0.

(d) The gamma distribution with parameters α and λ. The pdf of a gamma-distributed
random variable is

g(x;α, λ) =
⎧⎨
⎩

0, if x < 0,

xα−1λαe−λx/�(α), if x ≥ 0,

where the parameters α and λ are both positive and � is the gamma function
defined as

�(α) =
∫ ∞

0
xα−1e−x dx.
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Note that f is the exponential pdf when α = 1 and that when α is a positive integer

�(α) = (α − 1)! with 0! defined to be 1.

(e) The chi-squared distribution with ν degrees of freedom. For each positive integer
ν, the chi-squared distribution with ν degrees of freedom is defined to be the
distribution of the sum

X = Z2
1 + · · · + Z2

ν ,

where Z1, . . . ,Zν are independent normally distributed random variables with
mean 0 and variance 1. This distribution is the same as the gamma distribution
with parameters α = ν/2 and λ = 1

2 .

A.1.2 Examples of Discrete Distributions

(f) The binomial distribution with parameters n and p. The pmf of a binomially
distributed random variable X with parameters n and p is

b( j; n, p) = P[X = j ] =
(
n

j

)
p j(1 − p)n−j, j = 0, 1, . . . , n,

where n is a positive integer and 0 ≤ p ≤ 1.
(g) The uniform distribution on {1, 2, . . . , k}. The pmf of a random variable X uni-

formly distributed on {1, 2, . . . , k} is
p( j ) = P[X = j ] = 1

k
, j = 1, 2 . . . , k,

where k is a positive integer.
(h) The Poisson distribution with parameter λ. A random variable X is said to have a

Poisson distribution with parameter λ > 0 if

p( j;λ) = P[X = j ] = λj

j! e
−λ, j = 0, 1, . . . .

We shall see in Example A.1.2 below that λ is the mean of X.
(i) The negative binomial distribution with parameters α and p. The random variable

X is said to have a negative binomial distribution with parameters α > 0 and
p ∈ [0, 1] if it has pmf

nb( j;α, p) =
(

j∏
k=1

k − 1 + α

k

)
(1 − p) jpα, j = 0, 1, . . . ,

where the product is defined to be 1 if j = 0.

Not all random variables can be neatly categorized as either continuous or discrete.
For example, consider the time you spend waiting to be served at a checkout counter
and suppose that the probability of finding no customers ahead of you is 1

2 . Then the
time you spend waiting for service can be expressed as

W =

⎧⎪⎪⎨
⎪⎪⎩

0, with probability
1

2
,

W1, with probability
1

2
,



356 Appendix A Random Variables and Probability Distributions

whereW1 is a continuous random variable. If the distribution ofW1 is exponential with
parameter 1, then the distribution function of W is

F(x) =
⎧⎨
⎩

0, if x < 0,

1

2
+ 1

2

(
1 − e−x

) = 1 − 1

2
e−x, if x ≥ 0.

This distribution function is neither continuous (since it has a discontinuity at x = 0)
nor discrete (since it increases continuously for x > 0). It is expressible as a mixture,

F = pFd + (1 − p)Fc,

with p = 1
2 , of a discrete distribution function

Fd =
⎧⎨
⎩

0, x < 0,

1, x ≥ 0,

and a continuous distribution function

Fc =
⎧⎨
⎩

0, x < 0,

1 − e−x, x ≥ 0.

Every distribution function can in fact be expressed in the form

F = p1Fd + p2Fc + p3Fsc,

where 0 ≤ p1, p2, p3 ≤ 1, p1 + p2 + p3 = 1, Fd is discrete, Fc is continuous, and Fsc

is singular continuous (continuous but not of the form A.1.2). Distribution functions
with a singular continuous component are rarely encountered.

A.1.3 Expectation, Mean, and Variance

The expectation of a function g of a random variable X is defined by

E (g(X)) =
∫

g(x) dF(x),

where

∫
g(x) dF(x) :=

⎧⎪⎪⎪⎪⎪⎨
⎪⎪⎪⎪⎪⎩

∫ ∞

−∞
g(x)f (x) dx in the continuous case,

∞∑
j=0

g(xj)p(xj) in the discrete case,

and g is any function such that E|g(x)| < ∞. (If F is the mixture F = pFc+(1−p)Fd,
then E(g(X)) = p

∫
g(x) dFc(x) + (1 − p)

∫
g(x) dFd(x).) The mean and variance of

X are defined as μ = EX and σ 2 = E(X − μ)2, respectively. They are evaluated by
setting g(x) = x and g(x) = (x − μ)2 in the definition of E(g(X)).

It is clear from the definition that expectation has the linearity property

E(aX + b) = aE(X) + b

for any real constants a and b (provided that E|X| < ∞).
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Example A.1.1 The Normal Distribution

If X has the normal distribution with pdf n
(
x;μ, σ 2

)
as defined in Example (a) above,

then

E(X − μ) =
∫ ∞

−∞
(x − μ)n

(
x;μ, σ 2

)
dx = −σ 2

∫ ∞

−∞
n′(x : μ, σ 2

)
dx = 0.

This shows, with the help of the linearity property of E, that

E(X) = μ,

i.e., that the parameter μ is in fact the mean of the normal distribution defined in
Example (a). Similarly,

E(X−μ)2 =
∫ ∞

−∞
(x−μ)2n

(
x;μ, σ 2) dx = −σ 2

∫ ∞

−∞
(x−μ)n′(x;μ, σ 2) dx.

Integrating by parts and using the fact that f is a pdf, we find that the variance of X is

E(X − μ)2 = σ 2
∫ ∞

−∞
n
(
x;μ, σ 2) dx = σ 2.

�

Example A.1.2 The Poisson Distribution

The mean of the Poisson distribution with parameter λ (see Example (h) above) is
given by

μ =
∞∑
j=0

jλj

j! e
−λ =

∞∑
j=1

λλj−1

(j − 1)!e
−λ = λeλe−λ = λ.

A similar calculation shows that the variance is also equal to λ (see Problem A.2).
�

Remark. Functions and parameters associated with a random variable X will be
labeled with the subscript X whenever it is necessary to identify the particular random
variable to which they refer. For example, the distribution function, pdf, mean, and
variance of X will be written as FX, fX , μX , and σ 2

X , respectively, whenever it is
necessary to distinguish them from the corresponding quantities FY , fY , μY , and σ 2

Y
associated with a different random variable Y .

A.2 Random Vectors

An n-dimensional random vector is a column vector X = (X1, . . . ,Xn)
′ each of whose

components is a random variable. The distribution function F of X, also called the
joint distribution of X1, . . . ,Xn, is defined by

F(x1, . . . , xn) = P[X1,≤ x1, . . . ,Xn ≤ xn] (A.2.1)

for all real numbers x1, . . . , xn. This can be expressed in a more compact form as

F(x) = P[X ≤ x], x = (x1, . . . , xn)
′,

for all real vectors x = (x1, . . . , xn)′. The joint distribution of any subcollection
Xi1, . . . ,Xik of these random variables can be obtained from F by setting xj = ∞
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in (A.2.1) for all j /∈ {i1, . . . , ik}. In particular, the distributions of X1 and (X1,Xn)
′ are

given by

FX1(x1) = P[X1 ≤ x1] = F(x1,∞, . . . ,∞)

and

FX1,Xn(x1, xn) = P[X1 ≤ x1,Xn ≤ xn] = F(x1,∞, . . . ,∞, xn).

As in the univariate case, a random vector with distribution function F is said to be
continuous if F has a density function, i.e., if

F(x1, . . . , xn) =
∫ xn

−∞
· · ·

∫ x2

−∞

∫ x1

−∞
f (y1, . . . , yn) dy1 dy2 · · · dyn.

The probability density of X is then found from

f (x1, . . . , xn) = ∂nF(x1, . . . , xn)

∂x1 · · · ∂xn .

The random vector X is said to be discrete if there exist real-valued vectors x0, x1, . . .

and a probability mass function p(xj) = P[X = xj] such that

∞∑
j=0

p(xj) = 1.

The expectation of a function g of a random vector X is defined by

E (g(X)) =
∫

g(x) dF(x) =
∫

g(x1, . . . , xn) dF(x1, . . . , xn),

where∫
g(x1, . . . , xn) dF(x1, . . . , xn)

=

⎧⎪⎪⎪⎨
⎪⎪⎪⎩

∫
· · ·

∫
g(x1, . . . , xn) f (x1, . . . , xn) dx1 · · · dxn, in the continuous case,

∑
j1

· · ·
∑
jn

g(xj1 , . . . , xjn)p(xj1, . . . , xjn), in the discrete case,

and g is any function such that E|g(X)| < ∞.
The random variables X1, . . . ,Xn are said to be independent if

P[X1 ≤ x1, . . . ,Xn ≤ xn] = P[X1 ≤ x1] · · · P[Xn ≤ xn],
i.e.,

F(x1, . . . , xn) = FX1(x1) · · ·FXn(xn)

for all real numbers x1, . . . , xn. In the continuous and discrete cases, independence is
equivalent to the factorization of the joint density function or probability mass function
into the product of the respective marginal densities or mass functions, i.e.,

f (x1, . . . , xn) = fX1(x1) · · · fXn(xn) (A.2.2)

or

p(x1, . . . , xn) = pX1(x1) · · · pXn(xn). (A.2.3)

For two random vectors X = (X1, . . . ,Xn)
′ and Y = (Y1, . . . ,Ym)′ with joint

density function fX,Y, the conditional density of Y given X = x is
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fY|X(y|x) =

⎧⎪⎨
⎪⎩
fX,Y(x, y)
fX(x)

, if fX(x) > 0,

fY(y), if fX(x) = 0.

The conditional expectation of g (Y) given X = x is then

E(g(Y)|X = x) =
∫ ∞

−∞
g(y) fY|X(y|x) dy.

If X and Y are independent, then fY|X(y|x) = fY(y) by (A.2.2), and so the conditional
expectation of g(Y) given X = x is

E(g(Y)|X = x) = E( g(Y)),

which, as expected, does not depend on x. The same ideas hold in the discrete case
with the probability mass function assuming the role of the density function.

A.2.1 Means and Covariances

If E|Xi| < ∞ for each i, then we define the mean or expected value of X =
(X1, . . . ,Xn)

′ to be the column vector

μX = EX = (EX1, . . . ,EXn)
′.

In the same way we define the expected value of any array whose elements are random
variables (e.g., a matrix of random variables) to be the same array with each random
variable replaced by its expected value (if the expectation exists).

If X = (X1, . . . ,Xn)
′ and Y = (Y1, . . . ,Ym)′ are random vectors such that each Xi

and Yj has a finite variance, then the covariance matrix of X and Y is defined to be
the matrix


XY = Cov(X,Y) = E[(X − EX)(Y − EY)′]
= E(XY′) − (EX)(EY)′.

The (i, j) element of
XY is the covariance Cov(Xi,Yj) = E(XiYj)−E(Xi)E(Yj). In the
special case where Y = X, Cov(X,Y) reduces to the covariance matrix of the random
vector X.

Now suppose that Y and X are linearly related through the equation

Y = a + BX,

where a is an m-dimensional column vector and B is an m × n matrix. Then Y has
mean

EY = a + BEX (A.2.4)

and covariance matrix


YY = B
XXB
′ (A.2.5)

(see Problem A.3).

Proposition A.2.1 The covariance matrix 
XX of a random vector X is symmetric and nonnegative
definite, i.e., b′
XXb ≥ 0 for all vectors b = (b1, . . . , bn)′ with real components.

Proof Since the (i, j) element of 
XX is Cov(Xi, Xj) =Cov(Xj, Xi), it is clear that 
XX is
symmetric. To prove nonnegative definiteness, let b = (b1, . . . , bn)′ be an arbitrary
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vector. Then applying (A.2.5) with a = 0 and B = b, we have

b′
XXb = Var(b′X) = Var(b1X1 + · · · + bnXn) ≥ 0. �

Proposition A.2.2 Every n × n covariance matrix 
 can be factorized as


 = P�P′

where P is an orthogonal matrix (i.e., P′ = P−1) whose columns are an orthonormal
set of right eigenvectors corresponding to the (nonnegative) eigenvalues λ1, . . . , λn of

, and � is the diagonal matrix

� =

⎡
⎢⎢⎢⎣

λ1 0 · · · 0
0 λ2 · · · 0
...

...
. . .

...

0 0 · · · λn

⎤
⎥⎥⎥⎦ .

In particular, 
 is nonsingular if and only if all the eigenvalues are strictly positive.

Proof Every covariance matrix is symmetric and nonnegative definite by Proposition A.2.1,
and for such matrices the specified factorization is a standard result (see Graybill 1983
for a proof). The determinant of an orthogonal matrix is 1 or −1, so that det(
) =
det(P) det(�) det(P) = λ1 · · · λn. It follows that 
 is nonsingular if and only if λi > 0
for all i. �

Remark 1. Given a covariance matrix 
, it is sometimes useful to be able to find a
square root A = 
1/2 with the property that AA′ = 
. It is clear from Proposition
A.2.2 and the orthogonality of P that one such matrix is given by

A = 
1/2 = P�1/2P′.

If 
 is nonsingular, then we can define


s = P�sP′, −∞ < s < ∞.

The matrix 
−1/2 defined in this way is then a square root of 
−1 and also the inverse
of 
1/2. �

A.3 The Multivariate Normal Distribution

The multivariate normal distribution is one of the most commonly encountered and
important distributions in statistics. It plays a key role in the modeling of time series
data. Let X = (X1, . . . ,Xn)

′ be a random vector.

Definition A.3.1 X has a multivariate normal distribution with mean μ and nonsingular covari-
ance matrix 
 = 
XX, written as X ∼ N(μ,
), if

fX(x) = (2π)−n/2(det 
)−1/2 exp

{
−1

2
(x − μ)′
−1(x − μ)

}
.
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If X ∼ N(μ, 
), we can define a standardized random vector Z by applying the
linear transformation

Z = 
−1/2(X − μ), (A.3.1)

where 
−1/2 is defined as in the remark of Section A.2. Then by (A.2.4) and (A.2.5),
Z has mean 0 and covariance matrix 
ZZ = 
−1/2

−1/2 = In, where In is the n× n
identity matrix. Using the change of variables formula for probability densities (see
Mood et al. 1974), we find that the probability density of Z is

fZ(z) = (det 
)1/2fX
(

1/2z + μ

)

= (det 
)1/2(2π)−n/2(det 
)−1/2 exp

{
−1

2
(
−1/2z)′
−1
−1/2z

}

= (2π)−n/2 exp
{

− 1

2
z′z
}

=
(

(2π)−1/2 exp
{

− 1

2
z2

1

})
· · ·

(
(2π)−1/2 exp

{
− 1

2
z2
n

})
,

showing, by (A.2.2), that Z1, . . . ,Zn are independent N(0, 1) random variables. Thus
the standardized random vector Z defined by (A.3.1) has independent standard normal
random components. Conversely, given any n× 1 mean vector μ, a nonsingular n× n
covariance matrix 
, and an n×1 vector of standard normal random variables, we can
construct a normally distributed random vector with mean μ and covariance matrix 


by defining

X = 
1/2Z + μ. (A.3.2)

(See Problem A.4.)

Remark 1. The multivariate normal distribution with mean μ and covariance matrix

 can be defined, evenwhen
 is singular, as the distribution of the vectorX in (A.3.2).
The singular multivariate normal distribution does not have a joint density, since
the possible values of X−μ are constrained to lie in a subspace of Rn with dimension
equal to rank(
). �

Remark 2. If X ∼N(μ, 
), B is an m × n matrix, and a is a real m × 1 vector, then
the random vector

Y = a + BX

is also multivariate normal (see Problem A.5). Note that from (A.2.4) and (A.2.5), Y
has mean a + Bμ and covariance matrix B
B′. In particular, by taking B to be the
row vector b′ = (b1, . . . , bn), we see that any linear combination of the components
of a multivariate normal random vector is normal. Thus b′X = b1X1 + · · · + bnXn ∼
N(b′μX,b′
XXb). �

Example A.3.1. The Bivariate Normal Distribution
Suppose that X = (X1,X2)

′ is a bivariate normal random vector with mean μ =
(μ1, μ2)

′ and covariance matrix


 =
[

σ 2
1 ρσ1σ2

ρσ1σ2 σ 2
2

]
, σ > 0, σ2 > 0, −1 < ρ < 1. (A.3.3)
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The parameters σ1, σ2, and ρ are the standard deviations and correlation of the compo-
nents X1 and X2. Every nonsingular 2-dimensional covariance matrix can be expressed
in the form (A.3.3). The inverse of 
 is


−1 = (
1 − ρ2)−1

[
σ−2

1 −ρσ−1
1 σ−1

2

−ρσ−1
1 σ−1

2 σ−2
2

]
,

and so the pdf of X is given by

fX(x) =
(

2πσ1σ2
(
1 − ρ2

)1/2
)−1

× exp

{
−1

2
(
1 − ρ2

)
[(

x1 − μ1

σ1

)2

−2ρ

(
x1 − μ1

σ1

)(
x2 − μ2

σ2

)
+
(
x2 − μ2

σ2

)2
]}

.

�
Multivariate normal random vectors have the important property that the condi-

tional distribution of any set of components, given any other set, is again multivariate
normal. In the following proposition we shall suppose that the nonsingular normal
random vector X is partitioned into two subvectors

X =
[
X(1)

X(2)

]
.

Correspondingly, we shall write the mean and covariance matrix of X as

μ =
[
μ(1)

μ(2)

]
and 
 =

[

11 
12


21 
22

]
,

where μ(i) = EX(i) and 
ij = E
(
X(i) − μ(i)

) (
X(j) − μ(i)

)′
.

Proposition A.3.1. i. X(1) and X(2) are independent if and only if 
12 = 0.

ii. The conditional distribution of X(1) given X(2) = x(2) is N
(
μ(1) + 
12


−1
22

(
x(2) −

μ(2)
)
, 
11 − 
12


−1
22 
21

)
. In particular,

E
(
X(1)|X(2) = x(2)

) = μ(1) + 
12

−1
22

(
x(2) − μ(2)

)
.

The proof of this proposition involves routine algebraic manipulations of the
multivariate normal density function and is left as an exercise (see Problem A.6).

Example A.3.2. For the bivariate normal random vector X in Example A.3.1, we immediately deduce
from Proposition A.3.1 that X1 and X2 are independent if and only if ρσ1σ2 = 0 (or
ρ = 0, since σ1 and σ2 are both positive). The conditional distribution of X1 given
X2 = x2 is normal with mean

E(X1|X2 = x2) = μ1 + ρσ1σ
−1
2 (x2 − μ2)

and variance

Var(X1|X2 = x2) = σ 2
1

(
1 − ρ2) .

�
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Definition A.3.2. {Xt} is aGaussian time series if all of its joint distributions aremultivariate normal,
i.e., if for any collection of integers i1, . . . , in, the random vector (Xi1, . . . ,Xin)

′ has
a multivariate normal distribution.

Remark 3. If {Xt} is a Gaussian time series, then all of its joint distributions are
completely determined by the mean function μ(t) = EXt and the autocovariance
function κ(s, t) = Cov(Xs,Xt). If the process also happens to be stationary, then
the mean function is constant (μt = μ for all t) and κ(t + h, t) = γ (h) for all t.
In this case, the joint distribution of X1, . . . ,Xn is the same as that of X1+h, . . . ,Xn+h

for all integers h and n > 0. Hence for a Gaussian time series strict stationarity is
equivalent to weak stationarity (see Section 2.1). �

Problems

A.1 Let X have a negative binomial distribution with parameters α and p, where α > 0
and 0 ≤ p < 1.
a. Show that the probability generating function of X

(
defined asM(s) = E

(
sX
))

is

M(s) = pα(1 − s + sp)−α, 0 ≤ s ≤ 1.

b. Using the property thatM′(1) = E(X) andM′′(1) = E(X2)−E(X), show that

E(X) = α(1 − p)/p and Var(X) = α(1 − p)/p2.

A.2 IfX has the Poisson distribution with mean λ, show that the variance of X is also λ.

A.3 Use the linearity of the expectation operator for real-valued random variables to
establish (A.2.4) and (A.2.5).

A.4 If 
 is an n × n covariance matrix, 
1/2 is the square root of 
 defined in the
remark of Section A.2, and Z is an n-vector whose components are independent
normal random variables with mean 0 and variance 1, show that

X = 
1/2Z + μ

is a normally distributed random vector with mean μ and covariance matrix 
.

A.5 Show that if X is an n-dimensional random vector such that X ∼ N(μ, 
), B is
a real m × n matrix, and a is a real-valued m-vector, then

Y = a + BX

is a multivariate normal random vector. Specify the mean and covariance matrix
of Y.

A.6 Prove Proposition A.3.1.

A.7 Suppose that X = (X1, . . . ,Xn)
′ ∼ N(0, 
) with 
 nonsingular. Using the

fact that Z, as defined in (A.3.1), has independent standard normal components,
show that (X − μ)′
−1(X − μ) has the chi-squared distribution with n degrees
of freedom (Section A.1, Example (e)).
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A.8 Suppose that X = (X1, . . . ,Xn)
′ ∼ N(μ, 
) with 
 nonsingular. If A is a

symmetric n × n matrix, show that E(X′AX) = trace(A
) + μ′
μ.

A.9 Suppose that {Xt} is a stationary Gaussian time series with mean 0 and autoco-
variance function γ (h). Find E(Xt|Xs) and Var(Xt|Xs), s �= t.
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B.1 Least Squares Estimation
B.2 Maximum Likelihood Estimation
B.3 Confidence Intervals
B.4 Hypothesis Testing

B.1 Least Squares Estimation

Consider the problem of finding the “best” straight line

y = θ0 + θ1x

to approximate observations y1, . . . , yn of a dependent variable y taken at fixed values
x1, . . . , xn of the independent variable x. The (ordinary) least squares estimates θ̂0,
θ̂1 are defined to be values of θ0, θ1 that minimize the sum

S(θ0, θ1) =
n∑

i=1

(yi − θ0 − θ1xi)
2

of squared deviations of the observations yi from the fitted values θ0 + θ1xi. (The
“sum of squares” S(θ0, θ1) is identical to the Euclidean squared distance between y
and θ01 + θ1x, i.e.,

S(θ0, θ1) = ‖y − θ01 − θ1x‖2,

where x = (x1, . . . , xn)′, 1 = (1, . . . , 1)′, and y = (y1, . . . , yn)′.) Setting the partial
derivatives of S with respect to θ0 and θ1 both equal to zero shows that the vector
θ̂ = (θ̂0, θ̂1)

′ satisfies the “normal equations”

X′Xθ̂ = X′y,
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where X is the n× 2 matrix X = [1, x]. Since 0 ≤ S(θ) and S(θ) → ∞ as ‖θ‖ → ∞,

the normal equations have at least one solution. If θ̂
(1)

and θ̂
(2)

are two solutions of the
normal equations, then a simple calculation shows that(

θ̂
(1) − θ̂

(2)
)′
X′X

(
θ̂

(1) − θ̂
(2)
)

= 0,

i.e., that Xθ̂
(1) = Xθ̂

(2)
. The solution of the normal equations is unique if and only if

the matrix X′X is nonsingular. But the preceding calculations show that even if X′X is
singular, the vector ŷ = Xθ̂ of fitted values is the same for any solution θ̂ of the normal
equations.

The argument just given applies equally well to least squares estimation for the
general linear model. Given a set of data points

(xi1, xi2, . . . , xim, yi), i = 1, . . . , n with m ≤ n,

the least squares estimate, θ̂ = (
θ̂1, . . . , θ̂m

)′
of θ = (θ1, . . . , θm)′ minimizes

S(θ) =
n∑

i=1

(yi − θ1xi1 − · · · − θmxim)2 = ∥∥y − θ1x(1) − · · · − θmx(m)
∥∥2

,

where y = (y1, . . . , yn)′ and x( j ) = (x1j, . . . , xnj)′, j = 1, . . . ,m. As in the previous
special case, θ̂ satisfies the equations

X′Xθ̂ = X′y,

where X is the n × m matrix X = [
x(1), . . . , x(m)

]
. The solution of this equation is

unique if and only if X′X nonsingular, in which case

θ̂ = (X′X)−1X′y.

If X′X is singular, there are infinitely many solutions θ̂ , but the vector of fitted values
Xθ̂ is the same for all of them.

Example B.1.1. To illustrate the general case, let us fit a quadratic function

y = θ0 + θ1x + θ2x
2

to the data

x 0 1 2 3 4

y 1 0 3 5 8

The matrix X for this problem is

X =

⎡
⎢⎢⎢⎢⎣

1 0 0
1 1 1
1 2 4
1 3 9
1 4 16

⎤
⎥⎥⎥⎥⎦ , giving (X′X)−1 = 1

140

⎡
⎣ 124 −108 20

−108 174 −40
20 −40 10

⎤
⎦ .

The least squares estimate θ̂ = (
θ̂0, θ̂1, θ̂2

)′
is therefore unique and given by

θ̂ = (X′X)−1X′y =
⎡
⎣ 0.6

−0.1
0.5

⎤
⎦ .
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The vector of fitted values is given by

ŷ = Xθ̂ = (0.6, 1, 2.4, 4.8, 8.2)′

as compared with the observed values

y = (1, 0, 3, 5, 8)′.
�

B.1.1 The Gauss–Markov Theorem

Suppose now that the observations y1, . . . , yn are realized values of random variables
Y1, . . . ,Yn satisfying

Yi = θ1xi1 + · · · + θmxim + Zi,

where Zi ∼ WN
(
0, σ 2

)
. Letting Y = (Y1, . . . ,Yn)

′ and Z = (Z1, . . . ,Zn)
′, we can

write these equations as

Y = Xθ + Z.

Assume for simplicity that the matrix X′X is nonsingular (for the general case see, e.g.,
Silvey 1975). Then the least squares estimator of θ is, as above,

θ̂ = (X′X)−1X′Y,

and the least squares estimator of the parameter σ 2 is the unbiased estimator

σ̂ 2 = 1

n − m

∥∥Y − Xθ̂
∥∥2

.

It is easy to see that θ̂ is also unbiased, i.e., that

E
(
θ̂
) = θ .

It follows at once that if c′θ is any linear combination of the parameters θi, i =
1, . . . ,m, then c′θ̂ is an unbiased estimator of c′θ . The Gauss–Markov theorem says
that of all unbiased estimators of c′θ of the form

∑n
i=1 aiYi, the estimator c′θ̂ has the

smallest variance.
In the special case where Z1, . . . ,Zn are IID N

(
0, σ 2

)
, the least squares estimator θ̂

has the distribution N
(
θ, σ 2(X′X)−1

)
, and (n − m)σ̂ 2/σ 2 has the χ2 distribution with

n − m degrees of freedom.

B.1.2 Generalized Least Squares

The Gauss–Markov theorem depends on the assumption that the errors Z1, . . . ,Zn are
uncorrelated with constant variance. If, on the other hand, Z = (Z1, . . . ,Zn)

′ has mean
0 and nonsingular covariance matrix σ 2
 where 
 �= I, we consider the transformed
observation vector U = R−1Y, where R is a nonsingular matrix such that RR′ = 
.
Then

U = R−1Xθ + W = Mθ + W,

where M = R−1X and W has mean 0 and covariance matrix σ 2I. The Gauss–Markov
theorem now implies that the best linear estimate of any linear combination c′θ is c′θ̂ ,
where θ̂ is the generalized least squares estimator, which minimizes

‖U − Mθ‖2.
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In the special case where Z1, . . . ,Zn are uncorrelated and Zi has mean 0 and variance
σ 2r2

i , the generalized least squares estimator minimizes the weighted sum of squares

n∑
i=1

1

r2
i

(Yi − θ1xi1 − · · · − θmxim)2.

In the general case, if X′X and 
 are both nonsingular, the generalized least squares
estimator is given by

θ̂ = (M′M)−1M′U.

Although the least squares estimator (X′X)−1X′Y is unbiased if E(Z) = 0, even when
the covariance matrix of Z is not equal to σ 2I, the variance of the corresponding
estimate of any linear combination of θ1, . . . , θm is greater than or equal to the
estimator based on the generalized least squares estimator.

B.2 Maximum Likelihood Estimation

The method of least squares has an appealing intuitive interpretation. Its application
depends on knowledge only of the means and covariances of the observations. Maxi-
mum likelihood estimation depends on the assumption of a particular distributional
form for the observations, known apart from the values of parameters θ1, . . . , θm.
We can regard the estimation problem as that of selecting the most appropriate
value of a parameter vector θ , taking values in a subset Θ of Rm. We suppose that
these distributions have probability densities p(x; θ), θ ∈ Θ . For a fixed vector of
observations x, the function L(θ) = p(x; θ ) on Θ is called the likelihood function. A
maximum likelihood estimate θ̂(x) of θ is a value of θ ∈ Θ that maximizes the value
of L(θ) for the given observed value x, i.e.,

L
(
θ̂
) = p

(
x; θ̂(x)

) = max
θ∈Θ

p(x; θ).

Example B.2.1. If x = (x1, . . . , xn)′ is a vector of observations of independent N(μ, σ 2) random
variables, the likelihood function is

L
(
μ, σ 2

) = 1(
2πσ 2

)n/2
exp

[
− 1

2σ 2

n∑
i=1

(xi − μ)2

]
, −∞ < μ < ∞, σ > 0.

Maximization of L with respect to μ and σ is equivalent to minimization of

−2 ln L
(
μ, σ 2) = n ln(2π) + 2n ln(σ ) + 1

σ 2

n∑
i=1

(xi − μ)2.

Setting the partial derivatives of −2 ln L with respect to μ and σ both equal to zero
gives the maximum likelihood estimates

μ̂ = x = 1

n

n∑
i=1

xi and σ̂ 2 = 1

n

n∑
i=1

(xi − x)2.

�
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B.2.1 Properties of Maximum Likelihood Estimators

The Gauss–Markov theorem lent support to the use of least squares estimation by
showing its property of minimum variance among unbiased linear estimators. Maxi-
mum likelihood estimators are not generally unbiased, but in particular cases they can
be shown to have small mean squared error relative to other competing estimators.
Their main justification, however, lies in their good large-sample behavior.

For independent and identically distributed observations with true probability
density p(·; θ 0) satisfying certain regularity conditions, it can be shown that the
maximum likelihood estimator θ̂ of θ 0 converges in probability to θ 0 and that the
distribution of

√
n
(
θ̂−θ0

)
is approximately normal with mean 0 and covariance matrix

I(θ0)
−1, where I(θ) is Fisher’s information matrix with (i, j) component

Eθ

[
∂ ln p(X; θ)

∂θi

∂ ln p(X; θ)

∂θj

]
.

In time series analysis the situation is rather more complicated than in the case
of iid observations. “Likelihood” in the time series context is almost always used in
the sense of Gaussian likelihood, i.e., the likelihood computed under the (possibly
false) assumption that the series is Gaussian. Nevertheless, estimators of ARMA
coefficients computed by maximization of the Gaussian likelihood have good large-
sample properties analogous to those described in the preceding paragraph. For details
see Brockwell and Davis (1991), Section 10.8.

B.3 Confidence Intervals

Estimation of a parameter or parameter vector by least squares or maximum likelihood
leads to a particular value, often referred to as a point estimate. It is clear that this
will rarely be exactly equal to the true value, and so it is important to convey some
idea of the probable accuracy of the estimator. This can be done using the notion of
confidence interval, which specifies a random set covering the true parameter value
with some specified (high) probability.

Example B.3.1. If X = (X1, . . . ,Xn)
′ is a vector of independent N

(
μ, σ 2

)
random variables, we saw

in Section B.2 that the random variable Xn = 1
n

∑n
i=1 Xi is the maximum likelihood

estimator of μ. This is a point estimator of μ. To construct a confidence interval for μ

from Xn, we observe that the random variable

Xn − μ

S/
√
n

has Student’s t-distribution with n − 1 degrees of freedom, where S is the sample

standard deviation, i.e., S2 = 1
n−1

∑n
i=1

(
Xi − Xn

)2
. Hence,

P

[
−t1−α/2 <

Xn − μ

S/
√
n

< t1−α/2

]
= 1 − α,

where t1−α/2 denotes the (1 − α/2) quantile of the t-distribution with n− 1 degrees of
freedom. This probability statement can be expressed in the form
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P
[
Xn − t1−α/2S/

√
n < μ < Xn + t1−α/2S/

√
n
] = 1 − α,

which shows that the random interval bounded by Xn ± t1−α/2S/
√
n includes the true

value μ with probability 1 − α. This interval is called a (1 − α) confidence interval
for the mean μ.

�

B.3.1 Large-Sample Confidence Regions

Many estimators of a vector-valued parameter θ are approximately normally dis-
tributed when the sample size n is large. For example, under mild regularity conditions,
the maximum likelihood estimator θ̂(X) of θ = (θ1, . . . , θm)′ is approximately
N
(
0, 1

n I(θ̂)−1
)
, where I(θ) is the Fisher information defined in Section B.2. Conse-

quently,

n
(
θ̂ − θ

)′
I
(
θ̂
)(

θ̂ − θ
)

is approximately distributed as χ2 with m degrees of freedom, and the random set of
θ-values defined by

n
(
θ − θ̂

)′
I
(
θ̂
)(

θ − θ̂
) ≤ χ2

1−α(m)

covers the true value of θ with probability approximately equal to 1 − α.

Example B.3.2. For iid observations X1, . . . ,Xn from N
(
μ, σ 2

)
, a straightforward calculation gives,

for θ = (
μ, σ 2

)′
,

I(θ) =
[
σ−2 0

0 σ−4/2

]
.

Thus we obtain the large-sample confidence region for
(
μ, σ 2

)′
,

n
(
μ − Xn

)2
/σ̂ 2 + n(σ 2 − σ̂ 2)2/

(
2σ̂ 4) ≤ χ2

1−α(2),

which covers the true value of θ with probability approximately equal to 1 − α. This
region is an ellipse centered at

(
Xn, σ̂

2
)
.

�

B.4 Hypothesis Testing

Parameter estimation can be regarded as choosing one from infinitely many possible
decisions regarding the value of a parameter vector θ . Hypothesis testing, on the other
hand, involves a choice between two alternative hypotheses, a “null” hypothesis H0

and an “alternative” hypothesis H1, regarding the parameter vector θ . The hypotheses
H0 and H1 correspond to subsets Θ0 and Θ1 of the parameter set Θ . The problem
is to decide, on the basis of an observed data vector X, whether or not we should
reject the null hypothesis H0. A statistical test of H0 can therefore be regarded as a
partition of the sample space into one set of values of X for which we reject H0 and
another for which we do not. The problem is to specify a test (i.e., a subset of the
sample space called the “rejection region”) for which the corresponding decision rule
performs well in practice.
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Example B.4.1. If X = (X1, . . . ,Xn)
′ is a vector of independent N(μ, 1) random variables, we may

wish to test the null hypothesis H0: μ = 0 against the alternative H1: μ �= 0. A
plausible choice of rejection region in this case is the set of all samples X for which∣∣Xn

∣∣ > c for some suitably chosen constant c. We shall return to this example after
considering those factors that should be taken into account in the systematic selection
of a “good” rejection region.

�

B.4.1 Error Probabilities

There are two types of error that may be incurred in the application of a statistical
test:

• type I error is the rejection of H0 when it is true.

• type II error is the acceptance of H0 when it is false.

For a given test (i.e., for a given rejection region R), the probabilities of error can both
be found from the power function of the test, defined as

Pθ (R), θ ∈ Θ,

where Pθ is the distribution of X when the true parameter value is θ . The probabilities
of a type I error are

α(θ) = Pθ(R), θ ∈ Θ0,

and the probabilities of a type II error are

β(θ) = 1 − Pθ(R), θ ∈ Θ1.

It is not generally possible to find a test that simultaneously minimizes α(θ) and β(θ)

for all values of their arguments. Instead, therefore, we seek to limit the probability of
type I error and then, subject to this constraint, to minimize the probability of type II
error uniformly on Θ1. Given a significance level α, an optimum level-α test is a test
satisfying

α(θ) ≤ α, for all θ ∈ Θ0,

that minimizes β(θ) for every θ ∈ Θ1. Such a test is called a uniformlymost powerful
(U.M.P.) test of level α. The quantity supθ∈Θ0

α(θ) is called the size of the test.
In the special case of a simple hypothesis vs. a simple hypothesis, e.g., H0: θ = θ0

vs. H1: θ=θ1, an optimal test based on the likelihood ratio statistic can be constructed
(see Silvey 1975). Unfortunately, it is usually not possible to find a uniformly most
powerful test of a simple hypothesis against a composite (more than one value of θ)
alternative. This problem can sometimes be solved by searching for uniformly most
powerful tests within the smaller classes of unbiased or invariant tests. For further
information see Lehmann (1986).

B.4.2 Large-Sample Tests Based on Confidence Regions

There is a natural link between the testing of a simple hypothesis H0: θ = θ0

vs. H1: θ �= θ0 and the construction of confidence regions. To illustrate this
connection, suppose that θ̂ is an estimator of θ whose distribution is approximately
N
(
θ, n−1I−1(θ)

)
, where I(θ) is a positive definite matrix. This is usually the case, for

example, when θ̂ is a maximum likelihood estimator and I(θ) is the Fisher information.
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As in Section B.3.1, we have

Pθ

(
n
(
θ − θ̂

)′
I
(
θ̂
)(

θ − θ̂
) ≤ χ2

1−α(m)
) ≈ 1 − α.

Consequently, an approximate α-level test is to reject H0 if

n
(
θ0 − θ̂

)′
I
(
θ̂
)(

θ0 − θ̂
)

> χ2
1−α(m),

or equivalently, if the confidence region determined by those θ’s satisfying

n
(
θ − θ̂

)′
I
(
θ̂
)(

θ − θ̂
) ≤ χ2

1−α(m)

does not include θ0.

Example B.4.2. Consider again the problem described in Example B.4.1. Since Xn ∼N
(
μ, n−1

)
, the

hypothesis H0: μ = 0 is rejected at level α if

n
(
Xn

)2
> χ2

1−α,1,

or equivalently, if

∣∣Xn

∣∣ >
�1−α/2

n1/2
.

�



C Mean Square Convergence

C.1 The Cauchy Criterion

The sequence Sn of random variables is said to converge in mean square to the random
variable S if

E(Sn − S)2 → 0 as n → ∞.

In particular, we say that the sum
∑n

k=1 Xk converges (in mean square) if there exists

a random variable S such that E
(∑n

k=1 Xk − S
)2 → 0 as n → ∞. If this is the case,

then we use the notation S = ∑∞
k=1 Xk.

C.1 The Cauchy Criterion

For a given sequence Sn of random variables to converge in mean square to some
random variable, it is necessary and sufficient that

E(Sm − Sn)
2 → 0 as m, n → ∞

(for a proof of this see Brockwell and Davis (1991), Chapter 2). The point of the
criterion is that it permits checking for mean square convergence without having to
identify the limit of the sequence.

Example C.1.1. Consider the sequence of partial sums Sn = ∑n
t=−n atZt, n = 1, 2, . . ., where {Zt} ∼

WN
(
0, σ 2

)
. Under what conditions on the coefficients ai does this sequence converge

in mean square? To answer this question we apply the Cauchy criterion as follows. For
n > m > 0,
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E(Sn − Sm)2 = E

⎛
⎝ ∑

m<|i|≤n

aiZi

⎞
⎠

2

= σ 2
∑

m<|i|≤n

a2
i .

Consequently, E(Sn − Sm)2 → 0 if and only if
∑

m<|i|≤n a
2
i → 0. Since the Cauchy

criterion applies also to real-valued sequences, this last condition is equivalent to
convergence of the sequence

∑n
i=−n a

2
i , or equivalently to the condition

∞∑
i=−∞

a2
i < ∞. (C.1.1)

�

Properties of Mean Square Convergence:
If Xn → X and Yn → Y , in mean square as n → ∞, then

(a) E
(
X2
n

) → E
(
X2
)

,

(b) E(Xn) → E(X),

and

(c) E(XnYn) → E(XY).

Proof. See Brockwell and Davis (1991), Proposition 2.1.2. �



D Lévy Processes, Brownian
Motion and Itô Calculus

D.1 Lévy Processes
D.2 Brownian Motion and the Itô Integral
D.3 Itô Processes and Itô’s Formula
D.4 Itô Stochastic Differential Equations

D.1 Lévy Processes

Just as ARMA processes were defined as stationary solutions of stochastic difference
equations driven by white noise, the so-called CARMA (continuous-time ARMA)
models arise as stationary solutions of stochastic differential equations driven by Lévy
processes. In order to discuss these equations in more detail we first present a few
essential facts concerning Lévy processes. (For detailed accounts see Protter 2010;
Applebaum 2004; Bertoin 1996; Sato 1999.) They have already been introduced in
Definition 7.5.1, but for ease of reference we repeat the definition here.

Definition D.1.1. A Lévy process, {L(t), t ∈ R} is a process with the following properties:

(i) L(0) = 0.

(ii) L(t) − L(s) has the same distribution as L(t− s) for all s and t such that s ≤ t.

(iii) If (s, t) and (u, v) are disjoint intervals then L(t) − L(s) and L(v) − L(u) are
independent.

(iv) {L(t)} is continuous in probability, i.e. for all ε > 0 and for all t ∈ R,

lim
s→t

P(|L(t) − L(s)| > ε) = 0.

© Springer International Publishing Switzerland 2016
P.J. Brockwell, R.A. Davis, Introduction to Time Series and Forecasting,
Springer Texts in Statistics, DOI 10.1007/978-3-319-29854-2

375



376 Appendix D Lévy Processes, Brownian Motion and Itô Calculus

It is known that every Lévy process has a version with sample-paths which are right
continuous with left limits (càdlàg for short). We shall therefore assume that our Lévy
processes have this property.

The characteristic function of L(t), φt(θ) := E(exp(iθL(t))), has the celebrated
Lévy-Khinchin representation, for t ≥ 0,

φt(θ) = exp(tξ(θ)), θ ∈ R,

where

ξ(θ) = iθμ − 1

2
θ2σ 2 +

∫
R

(eiθx − 1 − iθxI(−1,1)(x))ν(dx),

for some μ ∈ R, σ ≥ 0, and measure ν. I(−1,1) is the indicator function of the set
(−1, 1). The measure ν is known as the Lévy measure of the process L and satisfies
the conditions

ν({0}) = 0

and ∫
R

min(1, |u|2)ν(du) < ∞.

The triplet (σ 2, ν, μ) is often referred to as the characteristic triplet of the Lévy process
and completely determines all of its finite-dimensional distributions.

The measure ν characterizes the distribution of the jumps of the process. If, in
particular, ν is the zero measure then the characteristic function of L(t) for t ≥ 0, is
that of a normal random variable with E(L(t)) = μt and Var(L(t)) = σ 2t and the
process {L(t), t ∈ R} is Brownian motion (Example 7.5.1) with sample-paths which
are continuous (but nowhere differentiable).

If λ := ν(R) < ∞ then the expected number of jumps in any time-interval of
length t is λt and the expected number of jumps with size in (−∞, x] in the same
time interval is tν((−∞, x]) = λtF(x) where F is a probability distribution function.
The distribution function F is known as the jump-size distribution and λ is known as
the mean jump-rate. If σ 2 = 0 and m = λ

∫
(−1,1)

xdF(x), then {L(t)} is a compound
Poisson process with parameters λ andF (Example 7.5.2) and with sample paths which
are constant except for jumps.

If λ = ∞ then the expected number of jumps in every interval of positive length
is infinite and the process {L(t)} is said to have infinite activity. The gamma process
of Example 11.5.1 is such a process with characteristic triplet (0, ν, α(1 − e−β)/β),
where ν is the measure defined on subsets of (0,∞) by,

ν(dx) = αx−1e−βxI(0,∞)(x)dx.

The Lévy-Khinchin representation of the characteristic function of L(t) shows that
the distribution of L(t) can, by appropriate choice of the characteristic triplet, be any
infinitely divisible distribution. This family includes a vast array of distributions such
as the normal distributions, compound Poisson distributions, Student’s t-distributions,
the stable distributions and many others. In particular it includes distributions which
have heavy tails and which are not necessarily symmetric. These features allow for
great flexibility when modelling observed phenomena in both financial and physical
contexts.

In this appendix we shall restrict attention to Lévy processes for which
EL(1)2 < ∞. This constraint is not serious for most applications in finance where
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it is generally believed that second moments exist while higher moments (those of
order four or more) may not. For Lévy processes with EL(1)2 < ∞ it follows from
the definition that there are finite constants m and s ≥ 0 such that

EL(t) = mt and Var(L(t)) = s2t for all t ≥ 0.

In the following sections we shall focus on Brownian motion and stochastic
differential equations driven by Brownian motion.

In order to develop the necessary tools we introduce the Itô stochastic integral, Itô
processes and Itô’s formula. Following this we shall outline some results concerning
the solution of stochastic differential equations and use them to expand on the
treatment of Gaussian CARMA processes and their Lévy-driven generalizations in
Section 11.5.

D.2 Brownian Motion and the Itô Integral

Robert Brown (1828) observed the erratic motion of pollen particles in a liquid which
was later explained by the irregular bombardment of the particles by the molecules of
the liquid. In order to provide amathematical model for the one-dimensional version of
this process, Einstein (1905) postulated the existence of a process satisfying conditions
(i)–(iii) of Definition D.1.1 with L(t) normally distributed for every t. Bachelier (1900)
had in fact already proposed such a model for the prices of stocks on the Paris stock
exchange. It was later shown byWiener that there is a process with continuous sample-
paths satisfying these conditions, a process which has come to be known as a Brownian
motion or Wiener process. It is in fact the only Lévy process with continuous sample-
paths, a feature which adds to its plausibility as a model for the physical process
originally observed by Brown. Although the sample-paths are continuous they are far
from smooth in the sense that they are nowhere differentiable. We shall not attempt to
prove these properties here but refer to the books of Mikosch (1998), Klebaner (2005)
and Oksendal (2013) for further details. In the following sections we shall give an
outline of the essentials of Itô calculus adapted from the more extensive treatment of
Øksendal.

For modelling more complex physical phenomena it is often appropriate to
suppose that the increment dX(t) of the observed process {X(t)} in the infinitesimally
small time interval (t, t + dt) satisfies an equation of the form

dX(t) = b(t,X(t))dt + σ (t,X(t))dB(t), S ≤ t ≤ T, (D.2.1)

where dB(t) denotes the increment of a standard Brownian motion in the same time
interval. In order to attach a precise meaning to (D.2.1) we first consider the following
discrete approximation. For any fixed positive integer n, consider the grid of time
points {2−nk, k ∈ Z} and define

tk =

⎧⎪⎨
⎪⎩

2−nk, if S ≤ 2−nk ≤ T,

S, if 2−nk < S,

T, if 2−nk > T.

(D.2.2)

A discrete approximation to (D.2.1) is then

Xn
j+1 = Xn

j + b(tj,X
n
j )�tj + σ (tj,X

n
j )�Bj, [2nS] ≤ j ≤ [2nT], (D.2.3)
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where Xn
j := X(tj), �tj := tj+1 − tj, and �Bj := B(tj+1) − B(tj). For given functions

b and σ and for any given initial condition, Xn
[2nS] = X(S), and values of B(tj), j ≤ k,

equation (D.2.3) can be solved recursively for Xn
j , j ≤ k. The solution satisfies

Xn
j+1 = X(S) +

∑
k≤j

b(tk,X
n
k )�tk +

∑
k≤j

σ (tk,X
n
k )�Bk, [2nS] ≤ j ≤ [2nT].

(D.2.4)

This suggests that, under suitable conditions, as n → ∞, the random variables
Xn
j , [2nS] ≤ j ≤ [2nT] + 1, approximate (in a sense to be specified) a random process

{X(t), S ≤ t ≤ T} satisfying

X(t) = X(S)+
∫ t

S
b(u,X(u))du+

∫ t

S
σ (u,X(u))dB(u), S ≤ t ≤ T, (D.2.5)

In order to make sense of these statements, and to solve equations of the form
(D.2.5) we must first define what is meant by the integrals on the right-hand side. We
shall do this for non-anticipating integrands. The random process {X(t)} is said to be
a non-anticipating function of {B(t)} if, for each t, X(t) is a function of {B(s), s ≤ t}.
This property is the continuous-time analogue of causality, which we introduced in
connection with ARMAprocesses in Chapter 3.We shall use the notationF t to denote
the class of random variables on (�,F ,P) (the probability space on which {B(t)} is
defined) which are functions of {B(s), s ≤ t}. In this terminology {X(t)} is a non-
anticipating function of {B(t)} if X(t) ∈ Ft for all t.

To deal with the first integral in (D.2.5) we consider integrals of the form∫ T

S
m(u)du, S < T, (D.2.6)

for functions m on R × � belonging to the family M (S,T) defined by the properties
(i)–(iii) below. For clarity we have suppressed the dependence on ω ∈ � in (D.2.5)
and (D.2.6), but in fact X and m are both functions on R× � with values X(u, ω) and
m(u, ω) respectively.

Defining properties of m ∈ M (S,T):

(i) m(·, ·) is a measurable function on R × �.

(ii) m(t, ·) ∈ Ft for each t ∈ R.

(iii) P
[∫ T

S |m(u, ω)|du < ∞
]

= 1.

For m ∈ M (S,T) the integrals
∫ t
S m(u)du, t ∈ [S,T], can be defined for all ω

outside a set of probability zero as straightforward Lebesgue integrals, continuous
in t. Specifying them to be zero on the exceptional subset of � defines

∫ t
S m(u)du, t ∈

[S,T], as a continuous function of t for each ω.
In order to attach a meaning to the second integral in (D.2.5) we need to define

integrals of the form∫ T

S
f (u)dB(u), S < T, (D.2.7)

where the random variables f (u), defined on the same probability space (�,F ,P) as
{B(t)}, satisfy the properties (i)–(iii) specified below. We shall denote the class of such
functions asN (S,T) and an integral of the form (D.2.7) as an Itô integral.
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Defining properties of f ∈ N (S,T):

(i) f (·, ·) is a measurable function on R × �.

(ii) f (t, ·) ∈ Ft for each t ∈ R.

(iii) E
[∫ T

S f (t, ω)2dt
]

< ∞.

The construction of the integral (D.2.7) is achieved by defining it for elementary
functions and then extending the definition to all functions f ∈ N (S,T). The function
e is an elementary function if for some positive integer n,

e(u, ω) =
∞∑

j=−∞
ej(ω)I(2−nj,2−n(j+1)](u), u ∈ R, ω ∈ �, (D.2.8)

where the random variables ej belong to Ftj for all j and the times tj are defined as in
(D.2.2). Since the function e(u, ω) is independent of u on the interval (2−nj, 2−n(j+1)],
and since B increases on that interval by �Bj := B(tj+1) − B(tj), it is natural to define
(suppressing ω as in (D.2.7)),

IS,T(e) =
∫ T

S
e(u)dB(u) :=

∞∑
j=−∞

ej�Bj, S < T. (D.2.9)

Proposition D.2.1. If e is bounded and elementary then

E

(∫ T

S
e(u)dB(u)

)2

= E

(∫ T

S
e(u)2du

)
, S < T. (D.2.10)

Proof. Observing that E(eiej�Bi�Bj) = δijE(e2
j )�tj, where δij = 1 if i = j and 0 otherwise,

we can rewrite the left-hand side of (D.2.10) as

E
∞∑

i=−∞

∞∑
j=−∞

(eiej�Bi�Bj) =
∞∑

j=−∞
E(e2

j )�tj = E
∞∑

j=−∞
e2
j �tj = E

∫ T

S
e(t)2 dt.

�

Remark 1. The left-hand side of (D.2.10) is the squared norm of the random variable
IS,T(e) defined on (�,F ,P). The right-hand side is the squared norm of the function

e∗(u, ω) :=
{
e(u, ω), if (u, ω) ∈ [S,T] × �,

0, otherwise,

a square integrable function on the product space [S,T]×� with respect to the product
measure � × P, where � denotes Lebesgue measure. The mapping e �→ IS,T(e) thus
determines an isometry from the restrictions e∗ of the bounded elementary functions
e to [S,T] × � into the space of square integrable random variables on (�,F ,P).

It can be shown (see e.g., Oksendal 2013) that for every function f ∈ N (S,T)

there is a sequence of bounded elementary functions {en} such that

E
∫ T

S
(en(u) − f (u))2du → 0 as n → ∞. (D.2.11)
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This implies that E
∫ T
S (en(u) − em(u))2du → 0 as m and n both go to ∞ and, by the

isometry, that

E(IS,T(en − em))2 = E
(
IS,T(en) − IS,T(em)

)2 → 0.

By the Cauchy property of mean square convergence (Appendix C.1) it follows that
{IS,T(en)} has a mean square limit.

If {gn} is another sequence of bounded elementary functions with the property
(D.2.11) then E

∫ T
S (en(u) − gn(u))2du → 0 as n → ∞ so that

E(IS,T((en − gn))
2 = E(IS,T(en) − IS,T(gn))

2 → 0.

Hence the mean square limit of IS,T(en) is the same for all sequences of bounded
elementary functions satisfying (D.2.11) and the common limit is defined to be IS,T(f ).
Thus IS,T(f ) can be defined unambiguously as

IS,T(f ) := lim
m.s.

IS,T(en), (D.2.12)

where {en} is any sequence of bounded elementary functions satisfying (D.2.11).
Moreover if f ∈ N (S,T) and {en} satisfies (D.2.11), then

E
(
IS,T(f )

2
) = lim

n→∞E
(
IS,T(en)

2
) = lim

n→∞E
∫ T

S
e2
n(u)du = E

∫ T

S
f 2(u)du,

showing that the isometry of the restrictions e∗ of bounded elementary functions
extends to the corresponding restrictions f ∗ of all functions in N (S,T).

This means that, in principle, IS,T(f ) can be evaluated as the mean-square limit
of
∫ T
S xn(u)dB(u) where {xn} is any (not necessarily bounded) sequence of elementary

functions such that E
∫ T
S (xn(u) − f (u))2du → 0 as n → ∞. In particular it can be

shown in this way that∫ T

S
B(u)dB(u) = 1

2
(B2(T) − B2(S)) − 1

2
(T − S).

We shall not go into the details as we shall derive this result in a much simpler way
using the tools of Itô calculus to be discussed in the following section. �

Remark 2. If f ∈ N (S,T) then for each t ∈ [S,T] so also is the function,
{f (ω, u)1[S,t](u), ω ∈ �, u ∈ R}, where 1[S,t] is the indicator function of the set [S, t].
This enables us to define∫ t

S
f (u)dB(u) :=

∫ T

S
f (u)1[S, t](u)du

for each t ∈ [S,T] and each f ∈ N (S,T). �

Remark 3. If f ∈ N := ∩N (S,T), where ∩ denotes the intersection over all S ∈ R

and T ∈ R such that S ≤ T , then Is,t(f ) is defined for all real-valued s and t such that
s ≤ t and the integral has the properties,

(i) EIs,t(f ) = 0.
(ii) Is,u(f ) = Is,t(f ) + It,u(f ), s ≤ t ≤ u.
(iii) Is,t(af + bg) = aIs,t(f ) + bIs,t(g) for all a, b ∈ R and g ∈ N .
(iv) E

[
Is,t(f )Is,t(g)

] = E
∫ t
s f (u)g(u)du for all g ∈ N .
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(v) For each fixed s ∈ R, {Is,t(f ), t ≥ s} is an Ft-martingale, i.e. E|Is,t(f )| < ∞ and

E(Is,u(f )|B(y), y ≤ t) = Is,t(f ), u ≥ t ≥ s.

(vi) For each fixed s ∈ R and for each fixed T ≥ s there is a version of {Is,t(f ), s ≤
t ≤ T} which is continuous in t. In other words there is a process {Xt, s ≤ t ≤ T}
with continuous sample-paths such that

P(Xt =
∫ t

s
f (u)dB(u)) = 1 for all t ∈ [s,T].

Properties (i)–(iv) are clearly true for bounded elementary functions f and g. Their
validity for functions in N can be established by taking limits. Property (v) follows
from (ii) and the independence of the increments of {B(t)}. The proof of property (vi)
is beyond the scope of this book [see, e.g., Oksendal (2013) for details]. �

D.3 Itô Processes and Itô’s Formula

Direct evaluation of Itô stochastic integrals from the definition (D.2.12) is very messy.
For example, it can be shown by a lengthy calculation from the definition that∫ t

0
B(u)dB(u) = 1

2
B(t)2 − 1

2
t.

Itô’s formula provides a chain rule for evaluating such integrals. It is clear from this
example that the classic rule for Riemann integration does not apply. If, for example,
we apply it in this particular case we find, from the rule d(x2) = 2xdx, that the integral
is 1

2B(t)2 instead of the correct expression above. Before we can derive the appropriate
rule however we first need to define what is meant by an Itô process.

Itô Process

This is a process which satisfies (suppressing the argument ω as before)

X(t) = X(s) +
∫ t

s
m(u)du +

∫ t

s
f (u)dB(u), s ≤ t ∈ R, (D.3.1)

where

X(t) ∈ Ft for all t ∈ R, (D.3.2)

m ∈ M (S,T) for all S ≤ T ∈ R (D.3.3)

and

f ∈ N ∗(S,T) for all S ≤ T ∈ R, (D.3.4)

with M (S,T) defined as in Section E.2 and N ∗(S,T) defined like N (S,T) in

Section E.2 except for the replacement of property (iii), E
[∫ T

S f (u)2du
]

< ∞, by

the weaker condition,
(iii)∗ P

[∫ T
S f (u)2du < ∞

]
= 1.

It can be shown that, under this weaker condition, the integrals Is,t(f ), s ≤ t ∈ R,
can still be defined, retaining all of the properties in Remark 3 of Section E.2 with the
exception of the martingale property (v).
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Definition (D.3.1) is often written in the shorthand notation,

dX(t) = m(t) dt + f (t) dB(t). (D.3.5)

Both of the integrals in (D.3.1) are assumed to be continuous versions so that the Itô
process {X(t)} is also continuous. The first integral is usually referred to as the drift
component of {X(t)} and the second as the Brownian component.

Itô’s Formula
Itô’s formula is concerned with smooth functions of Itô processes. Specifically it

states that if {X(t)} is an Itô process satisfying (D.3.5) and {g(t, x)} is a function on
R × R with continuous partial derivatives ∂g/∂t and ∂2g/∂x2 then

(i) Y(t) := g(t,X(t)) is an Itô process and

(ii)

dY(t) = ∂g

∂t
(t,X(t)) dt + ∂g

∂x
(t,X(t)) dX(t) + 1

2

∂2g

∂x2
(t,X(t)) (dX(t))2,

(D.3.6)

where dX(t) = m dt + f dB(t) and (dX(t))2 = f 2 dt.

Writing gt, gx and gxx for the corresponding partial derivatives of g evaluated at
(t,X(t)), and substituting for dX(t) and dX(t)2 as indicated in (ii), we can write the
increment of Y(t) explicitly in the form (D.3.5) as

dY(t) = (gt + mgx + 1

2
v2gxx) dt + fgx dB(t). (D.3.7)

Example D.3.1.
∫ t

0 B(u)dB(u)

Inspection of (D.3.7) suggests that in order to find a process with increments B(u)dB(u)
we should start with the Itô process X(t) = B(t), for whichm = 0 and f = 1, and define
Y(t) = g(t,X(t)) where gx(t, x) = x. Taking g(t, x) = x2/2 we obtain, from (D.3.7),

dY(t) = 1

2
dt + B(t)dB(t),

which gives∫ t

0
B(u)dB(u) = Y(t) − Y(0) − 1

2
t = 1

2
B(t)2 − 1

2
t.

�
Multivariate Itô Processes
An n-dimensional Itô process {X(t)} is defined to be an n-dimensional vector-valued
process satisfying an equation (cf. (D.3.5),

dX(t) = m(t) dt + F(t) dB(t), (D.3.8)

where {B(t)} is m-dimensional standard Brownian motion, i.e. an m-dimensional
random process with components which are independent one-dimensional standard
Brownian motions, the components of the n-vectors X(t) andm(t) satisfy (D.3.2) and
(D.3.3) respectively, and each component fij of the n×mmatrix F(t) satisfies (D.3.4).
The more explicit form of (D.3.8), corresponding to (D.3.1), is

X(t) = X(s) +
∫ t

s
m(u) du +

∫ t

s
F(u) dB(u), s ≤ t ∈ R. (D.3.9)
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The Multidimensional Itô Formula
The multidimensional version of Itô’s formula states that if {X(t)} is an n-dimensional
Itô process satisfying (D.3.9) and {g(t, x)} is a function on R × R

n with values in R
p

and with continuous second partial derivatives, then

(i) {Y(t) := g(t,X(t)) is a p-dimensional Itô process and

(ii)

dYi(t) = ∂gi
∂t

dt +
n∑

j=1

∂gi
∂xj

dXj(t) + 1

2

n∑
j=1

n∑
k=1

∂2gi
∂xj∂xk

dXj(t)dXk(t),

(D.3.10)

where Xi, Yi and gi are the components of X, Y and g respectively, and the partial
derivatives of g are all evaluated at (t,X(t)). The increments dXj satisfy the relations
dXj(t) = mj dt+∑n

r=1 fjr dBr(t) and dXj(t)dXk(t) = ∑n
r=1 fjrfkr dt, where mj and fij

are the components of m(t) and F(t) respectively.

In the following section we shall consider solutions of stochastic differential
equations of the form

dX(t) = b(t,X(t)) dt + σ (t,X(t)) dB(t), S < t < T, XS = Z, (D.3.11)

where {B(t)} ism-dimensional standard Brownian motion. Conditions on the functions
b and σ and the initial random variable Z which guarantee existence and uniqueness
of solutions will be specified in Theorem D.4.1, a proof of which can be found in
Oksendal (2013).

D.4 Itô Stochastic Differential Equations

The equation (D.3.11) is known as an Itô stochastic differential equation for the Rn-
valued random process {X(t)}. Equations (7.5.6), for geometric Brownian motion,
(11.5.2), for the CAR(1) process, and (11.5.9), for the state vector of a CARMA
process, are special cases. It is trivial to check, in each of these cases, that the conditions
on b and σ given in the following theorem are satisfied for all S and T ∈ Rwith T > S.
Provided the conditions on the initial random vector Z are satisfied, these guarantee
the existence and uniqueness of a continuous solution of (D.3.11). After stating the
theorem we shall use Itô’s formula to derive solutions of the particular Itô equations
(7.5.6) and (11.5.9). The solution of (11.5.2) was discussed in Section 11.5.1.

Theorem D.4.1. Suppose that S < T ∈ R and that the measurable functions b :
[S,T] × R

n �→ R
n and σ : [S,T] × R

n �→ R
n × R

m in (D.3.11) have the properties

|b(t, x)| + |σ (t, x)| < C(1 + |x|), x ∈ R
n, t ∈ [S,T]

and

|b(t, x − b(t, y)| + |σ (t, x − σ (t, y)| < D|x − y|,
where C and D are finite positive constants and |M| denotes the (positive) square root
of the sum of squares of the components of the matrix or vector M. If Z is a random
variable independent of {B(t) − B(s), S ≤ s < t ≤ T} such that E|Z|2 < ∞, then the
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stochastic differential equation (D.3.11) has a unique continuous (in t) solution, each
component of which belongs to N ∗[S,T] as defined in (D.3.4).

Geometric Brownian Motion
Geometric Brownian motion was introduced in Section 7.5.2 as a continuous-time
model for asset prices and was the basis for the derivations by Black and Scholes
(1973) andMerton (1973) of the option-pricing formula discussed in Section 7.6. Here
we shall use Itô’s formula to find the solution {P(t), t ≥ 0} of the defining differential
equation,

dP(t) = P(t)[μdt + σdB(t)], t ≥ 0, (D.4.1)

where P(0) is a strictly positive random variable, independent of {B(t) − B(s), 0 ≤
s ≤ t < ∞}. The standard calculus identity, d(log(y)) = dy/y, suggests that we try
applying Itô’s formula with X(t) = P(t) and g(x, t) = log(x). The function g has
continuous partial derivatives, ∂g/∂t = 0, ∂g/∂x = 1/x and ∂2g/∂x2 = −1/x2 on the
set where x > 0. Substituting in (D.3.6) and using (D.4.1) we obtain �

d(logP(t)) = 1

P(t)
dP(t) − 1

2P(t)2
(dP(t))2 = μdt + σdB(t) − σ 2

2
dt,

(D.4.2)

whence

log(P(t)) − log(P(0)) = (μ − σ 2

2
)t + σB(t).

This is equivalent to the solution (7.5.7) given earlier.

Gaussian CARMA Processes
The state equation (11.5.9) for the Gaussian CARMA(p, q) process, i.e.

dX(t) = AX(t)dt + edB(t), (D.4.3)

whereX(0) is independent of {B(t)−B(s), 0 ≤ s ≤ t ≤ T} and E|X(0)|2 < ∞, clearly
satisfies the conditions of Theorem D.4.1 and therefore has a unique solution which is
continuous in t. In order to find the solution we multiply both sides by the integrating
factor e−At, as we would if {B(t)} were deterministic. Since e−At is non-singular the
state equation is equivalent to the equation

e−AtdX(t) − e−AtAX(t)dt = e−AtedB(t). (D.4.4)

This form of the equation suggests applying the multivariate Itô formula with g(t, x) =
e−Atx. The second derivatives of g are all continuous and satisfy

∂2gi
∂xj∂xk

= 0 for all i, j and k,

∂gi
∂xj

= e′
ie

−Atej,

and
∂g
∂t

= −e′
iAe

−Atx.
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where er, r ∈ {1, . . . , p}, denotes a p-component column vector, all of whose
components are zero except for the rth, which is one. Substituting these derivatives
into (D.3.10) and writing the resulting equations in vector form we obtain

d(e−AtX(t)) = −Ae−AtX(t)dt + e−AtdX(t).

Substituting this expression in (D.4.4) gives

d(e−AtX(t)) = e−AtdB(t),

which implies that

e−AtX(t) − X(0) =
∫ t

0
e−AuedB(u),

or equivalently

X(t) = eAtX(0) +
∫ t

0
eA(t−u)edB(u), 0 ≤ t ≤ T. (D.4.5)

Since equation (D.4.1), with X(S) independent of {B(t) − B(s), S ≤ s ≤ t ≤ T}
and E|X(S)|2 < ∞, satisfies the conditions of Theorem D.4.1 for all S ∈ R and T ∈ R

such that S < T , exactly the same arguments give the more general relation,

X(t) = eA(t−S)X(S) +
∫ t

S
eA(t−u)e dB(u), t ≥ S, for all S ∈ R. (D.4.6)

This is equation (11.5.11) for which we showed (in Section 11.5.2) that the unique
causal stationary solution is

X(t) =
∫ t

−∞
eA(t−u)e dB(u), t ∈ R.

This led, with (11.5.8), to the definition of the zero-mean causal CARMA(p, q) process
{Y(t), t ∈ R} as

Y(t) =
∫ t

−∞
b′eA(t−u)e dB(u)

and, more generally in Section 11.5.3, to the second-order Lévy-driven CARMA(p, q)
process,

Y(t) =
∫

(−∞,t]
b′eA(t−u)e dL(u).
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yet supported by all versions of Windows so you may need to open ITSM_HELP.PDF
in a separate window while running the program.

When you unzip the downloaded zip file it will create a folder called ITSM2000
which contains all the necessary files for running the program. Double-click on the
ITSM icon or the ITSM-Shortcut icon to open the ITSM window. (You may wish
to copy and paste the ITSM-Shortcut icon to the desktop or some other convenient
location from which it can also be accessed.). The package ITSM2000 supersedes the
versions of the package ITSM2000 distributed with earlier editions of this book.
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E.1 Getting Started

E.1.1 Running ITSM

Double-clicking on the ITSM or the ITSM-Shortcut icon will open the ITSMwindow.
To analyze one of the data sets provided, select File>Project>Open at the top
left corner of the ITSM window.

There are several distinct functions of the program ITSM. The first is to analyze
and display the properties of time series data, the second is to compute and display the
properties of time series models, and the third is to combine these functions in order to
fit models to data. The last of these includes checking that the properties of the fitted
model match those of the data in a suitable sense. Having found an appropriate model,
we can (for example) then use it in conjunction with the data to forecast future values
of the series. Sections E.2–E.5 of this appendix deal with the modeling and analysis of
data, while Section E.6 is concerned with model properties. Section E.7 explains how
to open multivariate projects in ITSM. Examples of the analysis of multivariate time
series are given in Chapter 8.

It is important to keep in mind the distinction between data and model properties
and not to confuse the data with the model. In any one project ITSM stores one data
set and one model (which can be identified by highlighting the project window and
pressing the red INFO button at the top of the ITSMwindow). Until a model is entered
by the user, ITSM stores the default model of white noise with variance 1. If the data are
transformed (e.g., differenced and mean-corrected), then the data are replaced in ITSM
by the transformed data. (The original data can, however, be restored by inverting the
transformations.) Rarely (if ever) is a real time series generated by a model as simple
as those used for fitting purposes. In model fitting the objective is to develop a model
that mimics important features of the data, but is still simple enough to be used with
relative ease.

The following sections constitute a tutorial that illustrates the use of some of the
features of ITSMby leading you through a complete analysis of the well-known airline
passenger series of Box and Jenkins (1976) filed as AIRPASS.TSM in the ITSM2000
folder.

E.2 Preparing Your Data for Modeling

The observed values of your time series should be available in a single-column ASCII
file (or two columns for a bivariate series). The file, like those provided with the
package, should be given a name with suffix .TSM. You can then begin model
fitting with ITSM. The program will read your data from the file, plot it on the
screen, compute sample statistics, and allow you to make a number of transformations
designed to make your transformed data representable as a realization of a zero-mean
stationary process.

Example E.2.1. To illustrate the analysis we shall use the file AIRPASS.TSM, which contains the
number of international airline passengers (in thousands) for each month from January,
1949, through December, 1960.

�
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E.2.1 Entering Data

Once you have opened the ITSM window as described above under Getting Started,
select the options File>Project>Open,and youwill see a dialog box inwhich you
can check either Univariate or Multivariate. Since the data set for this
example is univariate, make sure that the univariate option is checked and then click
OK. A window labeled Open File will then appear, in which you can either type
the name AIRPASS.TSM and click Open, or else locate the icon for AIRPASS.TSM
in the Open File window and double-click on it. You will then see a graph of the
monthly international airline passenger totals (measured in thousands) X1, . . . ,Xn,
with n = 144. Directly behind the graph is a window containing data summary
statistics.

An additional, second, project can be opened by repeating the procedure described
in the preceding paragraph. Alternatively, the data can be replaced in the cur-
rent project using the option File>Import File. This option is useful if you
wish to examine how well a fitted model represents a different data set. (See the
entry ProjectEditor in the ITSM_HELPFiles for information on multiple project
management. Each ITSM project has its own data set and model.) For the purpose of
this introduction we shall open only one project.

E.2.2 Information

If, with the window labeled AIRPASS.TSM highlighted, you press the red INFO
button at the top of the ITSMwindow, you will see the sample mean, sample variance,
estimated standard deviation of the sample mean, and the current model (white noise
with variance 1).

Example E.2.2. Go through the steps in Entering Data to open the project AIRPASS.TSM and use the
INFO button to determine the sample mean and variance of the series.

�

E.2.3 Filing Data

You may wish to transform your data using ITSM and then store it in another file. At
any time before or after transforming the data in ITSM, the data can be exported to
a file by clicking on the red Export button, selecting Time Series and File,
clicking OK, and specifying a new file name. The numerical values of the series can
also be pasted to the clipboard (and from there into another document) in the same way
by choosing Clipboard instead of File. Other quantities computed by the program
(e.g., the residuals from the current model) can be filed or pasted to the clipboard in
the same way by making the appropriate selection in the Export dialog box. Graphs
can also be pasted to the clipboard by right-clicking on them and selecting Copy to
Clipboard.

Example E.2.3. Copy the series AIRPASS.TSM to the clipboard, open Wordpad or some convenient
screen editor, and choose Edit>Paste to insert the series into your new document.
Then copy the graph of the series to the clipboard and insert it into your document in
the same way.

�
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E.2.4 Plotting Data

A time series graph is automatically plotted when you open a data file (with time
measured in units of the interval between observations, i.e., t = 1, 2, 3, . . .). To see
a histogram of the data press the rightmost yellow button at the top of the ITSM
screen. If you wish to adjust the number of bins in the histogram, select
Statistics>Histogram>Set Bin Count and specify the number of bins
required. The histogram will then be replotted accordingly.

To insert any of the ITSM graphs into a text document, right-click on the graph
concerned, select Copy to Clipboard, and the graph will be copied to the
clipboard. It can then be pasted into a document opened by any standard text editor
such asMS-Word orWordpad using theEdit>Pasteoption in the screen editor. The
graph can also be sent directly to a printer by right-clicking on the graph and selecting
Print. Another useful graphics feature is provided by the white Zoom buttons at the
top of the ITSM screen. The first and second of these enable you to enlarge a designated
segment or box, respectively, of any of the graphs. The third button restores the original
graph.

Example E.2.4. Continuing with our analysis of AIRPASS.TSM, press the yellow histogram button
to see a histogram of the data. Replot the histogram with 20 bins by selecting
Statistics>Histogram>Set Bin Count.

�

E.2.5 Transforming Data

Transformations are applied in order to produce data that can be successfully modeled
as “stationary time series.” In particular, they are used to eliminate trend and cyclic
components and to achieve approximate constancy of level and variability with time.

Example E.2.5. The airline passenger data (see Figure 10-4) are clearly not stationary. The level and
variability both increase with time, and there appears to be a large seasonal component
(with period 12). They must therefore be transformed in order to be represented as
a realization of a stationary time series using one or more of the transformations
available for this purpose in ITSM.

�

Box–Cox Transformations
Box–Cox transformations are performed by selecting Transform>Box-Cox and
specifying the value of the Box–Cox parameter λ. If the original observations are
Y1,Y2, . . . ,Yn, the Box–Cox transformation fλ converts them to fλ(Y1), fλ(Y2), . . . ,

fλ(Yn), where

fλ(y) =

⎧⎪⎨
⎪⎩
yλ − 1

λ
, λ �= 0,

log(y), λ = 0.

These transformations are useful when the variability of the data increases or
decreases with the level. By suitable choice of λ, the variability can often be made
nearly constant. In particular, for positive data whose standard deviation increases
linearly with level, the variability can be stabilized by choosing λ = 0.

The choice of λ can be made visually by watching the graph of the data when
you click on the pointer in the Box–Cox dialog box and drag it back and forth along
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the scale, which runs from zero to 1.5. Very often it is found that no transformation is
needed or that the choice λ = 0 is satisfactory.

Example E.2.6. For the series AIRPASS.TSM, the variability increases with level, and the data are
strictly positive. Taking natural logarithms (i.e., choosing a Box–Cox transformation
with λ = 0) gives the transformed data shown in Figure E-1.

Notice how the amplitude of the fluctuations no longer increases with the level of
the data. However, the seasonal effect remains, as does the upward trend. These will
be removed shortly. The data stored in ITSM now consist of the natural logarithms of
the original data.

�

Classical Decomposition
There are two methods provided in ITSM for the elimination of trend and seasonality.
These are:

i. “classical decomposition” of the series into a trend component, a seasonal com-
ponent, and a random residual component, and

ii. differencing.

Classical decomposition of the series {Xt} is based on the model

Figure E-1
The series AIRPASS.TSM
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Xt = mt + st + Yt,

where Xt is the observation at time t, mt is a “trend component,” st is a “seasonal
component,” and Yt is a “random noise component,” which is stationary with mean
zero. The objective is to estimate the components mt and st and subtract them from the
data to generate a sequence of residuals (or estimated noise) that can then be modeled
as a stationary time series.

To achieve this, select Transform>Classical and you will see the Classical
Decomposition dialog box. To remove a seasonal component and trend, check the



392 Appendix E An ITSM Tutorial

Figure E-2
The logged AIRPASS.TSM
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Seasonal Fit and Polynomial Fit boxes, enter the period of the seasonal
component, and choose between the alternatives Quadratic Trend and Linear
Trend. Click OK, and the trend and seasonal components will be estimated and
removed from the data, leaving the estimated noise sequence stored as the current
data set.

The estimated noise sequence automatically replaces the previous data stored in
ITSM.

Example E.2.7. The logged airline passenger data have an apparent seasonal component of period
12 (corresponding to the month of the year) and an approximately quadratic trend.
Remove these using the option Transform>Classical as described above. (An
alternative approach is to use the option Regression,which allows the specification
and fitting of polynomials of degree up to 10 and a linear combination of up to 4 sine
waves.)

Figure E-2 shows the transformed data (or residuals) Yt, obtained by removal of
trend and seasonality from the logged AIRPASS.TSM series by classical decomposi-
tion. {Yt} shows no obvious deviations from stationarity, and it would now be reason-
able to attempt to fit a stationary time series model to this series. To see how well the
estimated seasonal and trend components fit the data, select Transform>Show
Classical Fit. We shall not pursue this approach any further here, but turn
instead to the differencing approach. (You should have no difficulty in later returning
to this point and completing the classical decomposition analysis by fitting a stationary
time series model to {Yt}.)

�

Differencing
Differencing is a technique that can also be used to remove seasonal components and
trends. The idea is simply to consider the differences between pairs of observations
with appropriate time separations. For example, to remove a seasonal component of
period 12 from the series {Xt}, we generate the transformed series
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Yt = Xt − Xt−12.

It is clear that all seasonal components of period 12 are eliminated by this trans-
formation, which is called differencing at lag 12. A linear trend can be eliminated
by differencing at lag 1, and a quadratic trend by differencing twice at lag 1 (i.e.,
differencing once to get a new series, then differencing the new series to get a second
new series). Higher-order polynomials can be eliminated analogously. It is worth
noting that differencing at lag 12 eliminates not only seasonal components with period
12 but also any linear trend.

Data are differenced in ITSM by selecting Transform>Difference
and entering the required lag in the resulting dialog box.

Example E.2.8. Restore the original airline passenger data using the option File>Import File
and selecting AIRPASS.TSM. We take natural logarithms as in Example E.2.6
by selecting Transform>Box-Cox and setting λ = 0. The transformed
series can now be deseasonalized by differencing at lag 12. To do this select
Transform>Difference, enter the lag 12 in the dialog box, and click OK.
Inspection of the graph of the deseasonalized series suggests a further differencing at
lag 1 to eliminate the remaining trend. To do this, repeat the previous step with lag
equal to 1 and you will see the transformed and twice-differenced series shown in
Figure E-3.

�

Subtracting the Mean
The term ARMA model is used in ITSM to denote a zero-mean ARMA process (see
Definition 3.1.1). To fit such a model to data, the sample mean of the data should
therefore be small. Once the apparent deviations from stationarity of the data have been
removed, we therefore (in most cases) subtract the sample mean of the transformed
data from each observation to generate a series to which we then fit a zero-mean
stationary model. Effectively we are estimating the mean of the model by the sample
mean, then fitting a (zero-mean) ARMA model to the “mean-corrected” transformed
data. If we know a priori that the observations are from a process with zero mean, then
this process of mean correction is omitted. ITSM keeps track of all the transformations

Figure E-3
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(including mean correction) that are made. When it comes time to predict the original
series, ITSM will invert all these transformations automatically.

Example E.2.9. Subtract the mean of the transformed and twice-differenced series AIRPASS.TSM by
selecting Transform>Subtract Mean. To check the current model status press
the red INFO button, and you will see that the current model is white noise with
variance 1, since no model has yet been entered.

�

E.3 Finding a Model for Your Data

After transforming the data (if necessary) as described above, we are now in a position
to fit an ARMA model. ITSM uses a variety of tools to guide us in the search
for an appropriate model. These include the sample ACF (autocorrelation function),
the sample PACF (partial autocorrelation function), and the AICC statistic, a bias-
corrected form of Akaike’s AIC statistic (see Section 5.5.2).

E.3.1 Autofit

Before discussing the considerations that go into the selection, fitting, and checking of
a stationary time series model, we first briefly describe an automatic feature of ITSM
that searches through ARMA(p, q) models with p and q between specified limits (less
than or equal to 27) and returns the model with smallest AICC value (see Sections 5.5.2
and E.3.5). Once the data set is judged to be representable by a stationary model,
select Model>Estimation>Autofit. A dialog box will appear in which you
must specify the upper and lower limits for p and q. Since the number of maximum
likelihood models to be fitted is the product of the number of p-values and the number
of q-values, these ranges should not be chosen to be larger than necessary. Once the
limits have been specified, press Start, and the search will begin. You can watch the
progress of the search in the dialog box that continually updates the values of p and
q and the best model found so far. This option does not consider models in which the
coefficients are required to satisfy constraints (other than causality) and consequently
does not always lead to the optimal representation of the data. However, like the tools
described below, it provides valuable information on which to base the selection of an
appropriate model.

E.3.2 The Sample ACF and PACF

Pressing the second yellow button at the top of the ITSM window will produce graphs
of the sample ACF and PACF for values of the lag h from 1 up to 40. For higher
lags choose Statistics>ACF/PACF>Specify Lag, enter the maximum lag
required, and click OK. Pressing the second yellow button repeatedly then rotates
the display through ACF, PACF, and side-by-side graphs of both. Values of the ACF
that decay rapidly as h increases indicate short-term dependency in the time series,
while slowly decaying values indicate long-term dependency. For ARMA fitting it
is desirable to have a sample ACF that decays fairly rapidly. A sample ACF that is
positive and very slowly decaying suggests that the data may have a trend. A sample
ACFwith very slowly damped periodicity suggests the presence of a periodic seasonal
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component. In either of these two cases you may need to transform your data before
continuing.

As a rule of thumb, the sample ACF and PACF are good estimates of the ACF and
PACF of a stationary process for lags up to about a third of the sample size. It is clear
from the definition of the sample ACF, ρ̂(h), that it will be a very poor estimator of
ρ(h) for h close to the sample size n.

The horizontal lines on the graphs of the sample ACF and PACF are the bounds
±1.96/

√
n. If the data constitute a large sample from an independent white noise

sequence, approximately 95% of the sample autocorrelations should lie between
these bounds. Large or frequent excursions from the bounds suggest that we need a
model to explain the dependence and sometimes to suggest the kind of model we need
(see below). To obtain numerical values of the sample ACF and PACF, right-click on
the graphs and select Info.

The graphs of the sample ACF and PACF sometimes suggest an appropriate
ARMA model for the data. As a rough guide, if the sample ACF falls between the
plotted bounds ±1.96/

√
n for lags h > q, then an MA(q) model is suggested, while if

the sample PACF falls between the plotted bounds ±1.96/
√
n for lags h > p, then an

AR(p) model is suggested.
If neither the sample ACF nor PACF “cuts off” as in the previous paragraph, a

more refined model selection technique is required (see the discussion of the AICC
statistic in Section 5.5.2). Even if the sample ACF or PACF does cut off at some lag,
it is still advisable to explore models other than those suggested by the sample ACF
and PACF values.

Example E.3.1. Figure E-4 shows the sample ACF of the AIRPASS.TSMseries after taking logarithms,
differencing at lags 12 and 1, and subtracting the mean. Figure E-5 shows the
corresponding sample PACF. These graphs suggest that we consider an MA model
of order 12 (or perhaps 23) with a large number of zero coefficients, or alternatively
an AR model of order 12.

�
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Figure E-5
The sample PACF
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E.3.3 Entering a Model

A major function of ITSM is to find an ARMA model whose properties reflect to
a high degree those of an observed (and possibly transformed) time series. Any
particular causal ARMA(p, q) model with p ≤ 27 and q ≤ 27 can be entered
directly by choosing Model>Specify, entering the values of p, q, the coeffi-
cients, and the white noise variance, and clicking OK. If there is a data set already
open in ITSM, a quick way of entering a reasonably appropriate model is to use
the option Model>Estimation>Preliminary,which estimates the coefficients
and white noise variance of an ARMAmodel after you have specified the orders p and
q and selected one of the four preliminary estimation algorithms available. An optimal
preliminary ARmodel can also be fitted by checking Find AR model with min
AICC in the Preliminary Estimation dialog box. If no model is entered or
estimated, ITSM assumes the default ARMA(0,0), or white noise, model

Xt = Zt,

where {Zt} is an uncorrelated sequence of random variables with mean zero and
variance 1.

If you have data and no particular ARMA model in mind, it is advisable to use
the option Model>Estimation>Preliminary or equivalently to press the blue
PRE button at the top of the ITSM window.

Sometimes you may wish to try a model found in a previous session or a
model suggested by someone else. In that case choose Model>Specify and enter
the required model. You can save both the model and data from any project by selecting
File>Project>Save as and specifying the name for the new file. When the new
file is opened, both the model and the data will be imported. To create a project with
this model and a new data set select File>Import File and enter the name of
the file containing the new data. (This file must contain data only. If it also contains
a model, then the model will be imported with the data and the model previously in
ITSM will be overwritten.)



E.3 Finding a Model for Your Data 397

E.3.4 Preliminary Estimation

The option Model>Estimation>Preliminary contains fast (but not the most
efficient) model-fitting algorithms. They are useful for suggesting the most promising
models for the data, but should be followed by maximum likelihood estimation
using Model>Estimation>Max likelihood. The fitted preliminary model is
generally used as an initial approximation with which to start the nonlinear optimiza-
tion carried out in the course of maximizing the (Gaussian) likelihood.

To fit an ARMAmodel of specified order, first enter the values of p and q (see Sec-
tion 2.6.1). For pure AR models q = 0, and the preliminary estimation option offers a
choice between the Burg and Yule–Walker estimates. (The Burg estimates frequently
give higher values of the Gaussian likelihood than the Yule–Walker estimates.) If q =
0, you can also check the box Find AR model with min AICC to allow the
program to fit ARmodels of orders 0, 1, . . . , 27 and select the one with smallest AICC
value (Section 5.5.2). For models with q > 0, ITSM provides a choice between two
preliminary estimation methods, one based on the Hannan–Rissanen procedure and
the other on the innovations algorithm. If you choose the innovations option, a default
value ofmwill be displayed on the screen. This parameter was defined in Section 5.1.3.
The standard choice is the default value computed by ITSM. The Hannan–Rissanen
algorithm is recommended when p and q are both greater than 0, since it tends
to give causal models more frequently than the innovations method. The latter is
recommended when p = 0.

Once the required entries in the Preliminary Estimation dialog box have been
completed, click OK, and ITSM will quickly estimate the parameters of the selected
model and display a number of diagnostic statistics. (If p and q are both greater than
0, it is possible that the fitted model may be noncausal, in which case ITSM sets
all the coefficients to .001 to ensure the causality required for subsequent maximum
likelihood estimation. It will also give you the option of fitting a model of different
order.)

Provided that the fitted model is causal, the estimated parameters are given with
the ratio of each estimate to 1.96 times its standard error. The denominator (1.96 ×
standard error) is the critical value (at level .05) for the coefficient. Thus, if the ratio is
greater than 1 in absolute value, we may conclude (at level .05) that the corresponding
coefficient is different from zero. On the other hand, a ratio less than 1 in absolute
value suggests the possibility that the corresponding coefficient in the model may be
zero. (If the innovations option is chosen, the ratios of estimates to 1.96 × standard
error are displayed only when p = q or p = 0.) In the Preliminary Estimates window
you will also see one or more estimates of the white noise variance (the residual
sum of squares divided by the sample size is the estimate retained by ITSM) and
some further diagnostic statistics. These are −2 ln L

(
φ̂, θ̂, σ̂ 2

)
, where L denotes the

Gaussian likelihood (5.2.9), and the AICC statistic

−2 ln L + 2(p + q + 1)n/(n − p − q − 2)

(see Section 5.5.2).
Our eventual aim is to find amodel with as small an AICCvalue as possible. Small-

ness of the AICC value computed in the preliminary estimation phase is indicative of a
good model, but should be used only as a rough guide. Final decisions between models
should be based on maximum likelihood estimation, carried out using the option
Model>Estimation>Max likelihood, since for fixed p and q, the values of
φ,θ, and σ 2 that minimize the AICC statistic are the maximum likelihood estimates,
not the preliminary estimates. After completing preliminary estimation, ITSM stores
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the estimated model coefficients and white noise variance. The stored estimate of the
white noise variance is the sum of squares of the residuals (or one-step prediction
errors) divided by the number of observations.

A variety of models should be explored using the preliminary estimation algo-
rithms, with a view to finding the most likely candidates for minimizing AICC when
the parameters are reestimated by maximum likelihood.

Example E.3.2. To find the minimum-AICC Burg AR model for the logged, differenced, and mean-
corrected series AIRPASS.TSM currently stored in ITSM, press the blue PRE button,
set the MA order equal to zero, select Burg and Find AR model with min
AICC, and then click OK. The minimum-AICC ARmodel is of order 12 with an AICC
value of −458.13. To fit a preliminary MA(25) model to the same data, press the blue
PRE button again, but this time set the AR order to 0, the MA order to 25, select
Innovations, and click OK.

The ratios (estimated coefficient)/(1.96× standard error) indicate that the coeffi-
cients at lags 1 and 12 are nonzero, as suggested by the sample ACF. The estimated
coefficients at lags 3 and 23 also look substantial even though the corresponding ratios
are less than 1 in absolute value. The displayed values are as follows:

MA COEFFICIENTS
−0.3568 0.0673 −0.1629 −0.0415 0.1268
0.0264 0.0283 −0.0648 0.1326 −0.0762

−0.0066 −0.4987 0.1789 −0.0318 0.1476
−0.1461 0.0440 −0.0226 −0.0749 −0.0456
−0.0204 −0.0085 0.2014 −0.0767 −0.0789

RATIO OF COEFFICIENTS TO (1.96*STANDARD ERROR)
−2.0833 0.3703 −0.8941 −0.2251 0.6875
0.1423 0.1522 −0.3487 0.7124 −0.4061

−0.0353 −2.6529 0.8623 −0.1522 0.7068
−0.6944 0.2076 −0.1065 −0.3532 −0.2147
−0.0960 −0.0402 0.9475 −0.3563 −0.3659

The estimated white noise variance is 0.00115 and the AICC value is −440.93, which
is not as good as that of the AR(12) model. Later we shall find a subset MA(25) model
that has a smaller AICC value than both of these models.

�

E.3.5 The AICC Statistic

The AICC statistic for the model with parameters p, q,φ, and θ is defined (see
Section 5.5.2) as

AICC(φ,θ) = −2 ln L(φ,θ, S(φ,θ)/n) + 2(p + q + 1)n/(n − p − q − 2),

and a model chosen according to the AICC criterion minimizes this statistic.
Model-selection statistics other than AICC are also available in ITSM.A Bayesian

modification of the AIC statistic known as the BIC statistic is also computed in the
option Model>Estimation>Max likelihood. It is used in the same way as
the AICC.

An exhaustive search for a model with minimum AICC or BIC value can be
very slow. For this reason the sample ACF and PACF and the preliminary estimation
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techniques described above are useful in narrowing down the range of models to
be considered more carefully in the maximum likelihood estimation stage of model
fitting.

E.3.6 Changing Your Model

The model currently stored by the program can be checked at any time by selecting
Model>Specify. Any parameter can be changed in the resulting dialog box,
including the white noise variance. The model can be filed together with the data for
later use by selecting File>Project>Save as and specifying a file name with
suffix .TSM.

Example E.3.3. Weshall now set some of the coefficients in the current model to zero. To do this choose
Model>Specify and click on the box containing the value −0.35676 of Theta(1).
Press Enter, and the value of Theta(2) will appear in the box. Set this to zero. Press
Enter again, and the value of Theta(3) will appear. Continue to work through the
coefficients, setting all except Theta(1), Theta(3), Theta(12), and Theta(23) equal to
zero. When you have reset the parameters, click OK, and the newmodel stored in ITSM
will be the subset MA(23) model

Xt = Zt − 0.357Zt−1 − 0.163Zt−3 − 0.499Zt−12 + 0.201Zt−23,

where {Zt} ∼ WN(0, 0.00115).
�

E.3.7 Maximum Likelihood Estimation

Once you have specified values of p and q and possibly set some coefficients to zero,
you can carry out efficient parameter estimation by selecting Model>Estimation>
Max likelihood or equivalently by pressing the blue MLE button.

The resulting dialog box displays the default settings, which in most cases will not
need to be modified. However, if you wish to compute the likelihood without maxi-
mizing it, check the box labeled No optimization. The remaining information
concerns the optimization settings. (With the default settings, any coefficients that are
set to zero will be treated as fixed values and not as parameters. Coefficients to be
optimized must therefore not be set exactly to zero. If you wish to impose further
constraints on the optimization, press the Constrain optimization button.
This allows you to fix certain coefficients or to impose multiplicative relationships
on the coefficients during optimization.)

To find the maximum likelihood estimates of your parameters, click OK, and the
estimated parameters will be displayed. To refine the estimates, repeat the estimation,
specifying a smaller value of the accuracy parameter in the Maximum Likelihood
dialog box.

Example E.3.4. To find the maximum likelihood estimates of the parameters in the model for the
logged, differenced, and mean-corrected airline passenger data currently stored in
ITSM, press the blue MLE button and click OK. The following estimated parameters
and diagnostic statistics will then be displayed:
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ARMA MODEL:
X(t) = Z(t)+(−.355) ∗ Z(t − 1)+(−.201) ∗ Z(t − 3)+(−.523) ∗ Z(t − 12)

+(.242) ∗ Z(t − 23)

WN Variance = .001250

MA Coefficients
THETA( 1)= -.355078 THETA( 3)= -.201125
THETA(12)= -.523423 THETA(23)= .241527
Standard Error of MA Coefficients
THETA( 1): .059385 THETA( 3): .059297
THETA(12): .058011 THETA(23): .055828

(Residual SS)/N = .125024E−02
AICC = -.486037E+03
BIC = -.487622E+03

-2 Ln(Likelihood)= -.496517E+03

Accuracy parameter = .00205000

Number of iterations = 5

Number of function evaluations = 46

Optimization stopped within accuracy level.

The last message indicates that the minimum of −2 ln L has been located with the
specified accuracy. If you see the message

Iteration limit exceeded,
then the minimum of −2 ln L could not be located with the number of iterations (50)
allowed. You can continue the search (starting from the point at which the iterations
were interrupted) by pressing the MLE button to continue the minimization and
possibly increasing the maximum number of iterations from 50 to 100.

�

E.3.8 Optimization Results

After maximizing the Gaussian likelihood, ITSMdisplays the model parameters (coef-
ficients and white noise variance), the values of −2 ln L, AICC, BIC, and information
regarding the computations.

Example E.3.5. The next stage of the analysis is to consider a variety of competing models and to select
the most suitable. The following table shows the AICC statistics for a variety of subset
moving average models of order less than 24.

Lags AICC

1 3 12 23 −486.04
1 3 12 13 23 −485.78
1 3 5 12 23 −489.95
1 3 12 13 −482.62
1 12 −475.91

The best of these models from the point of view of AICC value is the one with
nonzero coefficients at lags 1, 3, 5, 12, and 23. To obtain this model from the one
currently stored in ITSM, select Model>Specify, change the value of THETA(5)
from zero to .001, and click OK. Then reoptimize by pressing the blue MLE button and
clicking OK. You should obtain the noninvertible model
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Xt = Zt − 0.434Zt−1 − 0.305Zt−3 + 0.238Zt−5 − 0.656Zt−12 + 0.351Zt−23,

where {Zt} ∼ WN(0, 0.00103). For future reference, file the model and data as AIR-
PASS2.TSM using the option File>Project>Save as.

�
The next step is to check our model for goodness of fit.

E.4 Testing Your Model

Once we have a model, it is important to check whether it is any good or not. Typically
this is judged by comparing observations with corresponding predicted values obtained
from the fitted model. If the fitted model is appropriate then the prediction errors should
behave in a manner that is consistent with the model. The residuals are the rescaled
one-step prediction errors,

Ŵt = (Xt − X̂t)/
√
rt−1,

where X̂t is the best linear mean-square predictor of Xt based on the observations up
to time t − 1, rt−1 = E(Xt − X̂t)

2/σ 2 and σ 2 is the white noise variance of the fitted
model.

If the data were truly generated by the fitted ARMA(p, q) model with white noise
sequence {Zt}, then for large samples the properties of {Ŵt} should reflect those of {Zt}.
To check the appropriateness of the model we therefore examine the residual series
{Ŵt}, and check that it resembles a realization of a white noise sequence.

ITSM provides a number of tests for doing this in the Residuals Menu, which
is obtained by selecting the option Statistics>Residual Analysis.Within
this option are the suboptions

Plot
QQ-Plot (normal)
QQ-Plot (t-distr)
Histogram
ACF/PACF
ACF Abs vals/Squares
Tests of randomness

E.4.1 Plotting the Residuals

Select Statistics>Residual Analysis>Histogram, and you will see
a histogram of the rescaled residuals, defined as

R̂t = Ŵt/σ̂ ,

where nσ̂ 2 is the sum of the squared residuals. If the fitted model is appropriate, the
histogram of the rescaled residuals should have mean close to zero. If in addition the
data are Gaussian, this will be reflected in the shape of the histogram, which should
then resemble a normal density with mean zero and variance 1.

Select Statistics>Residual Analysis>Plot and you will see a graph
of R̂t vs. t. If the fitted model is appropriate, this should resemble a realization of
a white noise sequence. Look for trends, cycles, and nonconstant variance, any of
which suggest that the fitted model is inappropriate. If substantially more than 5% of
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the rescaled residuals lie outside the bounds ±1.96 or if there are rescaled residuals
far outside these bounds, then the fitted model should not be regarded as Gaussian.

Compatibility of the distribution of the residuals with either the normal distribution
or the t-distribution can be checked by inspecting the corresponding qq plots and
checking for approximate linearity. To test for normality, the Jarque–Bera statistic is
also computed.

Example E.4.1. The histogram of the rescaled residuals from our model for the logged, differenced,
and mean-corrected airline passenger series is shown in Figure E-6. The mean is close
to zero, and the shape suggests that the assumption of Gaussian white noise is not
unreasonable in our proposed model.

The graph of R̂t vs. t is shown in Figure E-7. A few of the rescaled residuals
are greater in magnitude than 1.96 (as is to be expected), but there are no obvious
indications here that the model is inappropriate. The approximate linearity of the
normal qq plot and the Jarque–Bera test confirm the approximate normality of the
residuals.

�

E.4.2 ACF/PACF of the Residuals

If we were to assume that our fitted model is the true process generating the data, then
the observed residuals would be realized values of a white noise sequence.

In particular, the sample ACF and PACF of the observed residuals should lie within
the bounds ±1.96/

√
n roughly 95% of the time. These bounds are displayed on the

graphs of the ACF and PACF. If substantially more than 5% of the correlations are
outside these limits, or if there are a few very large values, then we should look for
a better-fitting model. (More precise bounds, due to Box and Pierce, can be found in
Brockwell and Davis (1991) Section 10.4.)

Example E.4.2. Choose Statistics>Residual Analysis>ACF/PACF, or equivalently press
the middle green button at the top of the ITSM window. The sample ACF and PACF
of the residuals will then appear as shown in Figures E-8 and E-9. No correlations
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are outside the bounds in this case. They appear to be compatible with the hypothesis
that the residuals are in fact observations of a white noise sequence. To check for
independence of the residuals, the sample autocorrelation functions of their absolute
values and squares can be plotted by clicking on the third green button.

�

E.4.3 Testing for Randomness of the Residuals

The option Statistics>Residual Analysis>Tests of Randomness
carries out the six tests for randomness of the residuals described in Section 5.3.3.

Example E.4.3. The residuals from our model for the logged, differenced, and mean-corrected series
AIRPASS.TSM are checked by selecting the option indicated above and selecting the
parameter h for the portmanteau tests. Adopting the value h = 25 suggested by ITSM,
we obtain the following results:
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Figure E-9
Sample PACF of

the residuals from
AIRPASS.MOD Lag

P
A

C
F

0 10 20 30 40

− 0
.4

− 0
.2

0.
0

0.
2

0.
4

0.
6

0.
8

1.
0

RANDOMNESS TEST STATISTICS (see Section 5.3.3)

LJUNG-BOX PORTM.= 13.76 CHISQUR( 20), p-value = 0.843

MCLEOD-LI PORTM.= 17.39 CHISQUR( 25), p-value = 0.867

TURNING POINTS = 87. ANORMAL( 86.00, 4.79**2), p-value = 0.835

DIFFERENCE-SIGN = 65. ANORMAL( 65.00, 3.32**2), p-value = 1.000

RANK TEST = 3934. ANORMAL(4257.50, 251.3**2), p-value = 0.198

JARQUE–BERA = 4.33 CHISQUR(2) p-value = 0.115

ORDER OF MIN AICC YW MODEL FOR RESIDUALS = 0

Every test is easily passed by our fitted model (with significance level α = 0.05), and
the order of the minimum-AICCARmodel for the residuals supports the compatibility
of the residuals with white noise. For later use, file the residuals by pressing the red
EXP button and exporting the residuals to a file with the name AIRRES.TSM.

�
E.5 Prediction

One of the main purposes of time series modeling is the prediction of future observa-
tions. Once you have found a suitable model for your data, you can predict future
values using the option Forecasting>ARMA. (The other options listed under
Forecasting refer to the methods of Chapter 10.)

E.5.1 Forecast Criteria

Given observations X1, . . . ,Xn of a series that we assume to be appropriately modeled
as an ARMA(p, q) process, ITSM predicts future values of the series Xn+h from the
data and the model by computing the linear combination Pn(Xn+h) of X1, . . . ,Xn that
minimizes the mean squared error E(Xn+h − Pn(Xn+h))

2.
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E.5.2 Forecast Results

Assuming that the current data set has been adequately fitted by the current
ARMA(p, q) model, choose Forecasting>ARMA, and you will see the ARMA
Forecast dialog box.

You will be asked for the number of forecasts required, which of the transfor-
mations you wish to invert (the default settings are to invert all of them so as to
obtain forecasts of the original data), whether or not you wish to plot prediction
bounds (assuming normality), and if so, the confidence level required, e.g., 95%. After
providing this information, click OK, and the data will be plotted with the forecasts
(and possibly prediction bounds) appended. As is to be expected, the separation of the
prediction bounds increases with the lead time h of the forecast.

Right-click on the graph, select Info, and the numerical values of the predictors
and prediction bounds will be printed.

Example E.5.1. We left our logged, differenced, and mean-corrected airline passenger data stored in
ITSM with the subset MA(23) model found in Example D.3.5. To predict the next
24 values of the original series, select Forecasting>ARMA and accept the default
settings in the dialog box by clicking OK. You will then see the graph shown in
Figure E-10. Numerical values of the forecasts are obtained by right-clicking on the
graph and selecting Info. The ARMA Forecast dialog box also permits using a
model constructed from a subset of the data to obtain forecasts and prediction bounds
for the remaining observed values of the series.

�

E.6 Model Properties

ITSM can be used to analyze the properties of a specified ARMA process without
reference to any data set. This enables us to explore and compare the properties
of different ARMA models in order to gain insight into which models might best
represent particular features of a given data set.

Figure E-10
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For any ARMA(p, q) process or fractionally integrated ARMA(p, q) process
with p ≤ 27 and q ≤ 27, ITSM allows you to compute the autocorrelation and
partial autocorrelation functions, the spectral density and distribution functions, and
the MA(∞) and AR(∞) representations of the process. It also allows you to generate
simulated realizations of the process driven by either Gaussian or non-Gaussian noise.
The use of these options is described in this section.

Example E.6.1. We shall illustrate the use of ITSM for model analysis using the model for the trans-
formed series AIRPASS.TSM that is currently stored in the program.

�

E.6.1 ARMA Models

For modeling zero-mean stationary time series, ITSM uses the class of ARMA (and
fractionally integrated ARMA) processes. ITSM enables you to compute characteris-
tics of the causal ARMA model defined by

Xt = φ1Xt−1 + φ2Xt−2 + · · · + φpXt−p + Zt + θ1Zt−1 + θ2Zt−2 + · · · + θqZt−q,

or more concisely φ(B)Xt = θ(B)Zt, where {Zt} ∼ WN
(
0, σ 2

)
and the parameters are

all specified. (Characteristics of the fractionally integrated ARIMA(p, d, q) process
defined by

(1 − B)dφ(B)Xt = θ(B)Zt, |d| < 0.5,

can also be computed.)
ITSMworks exclusively with causal models. It will not permit you to enter amodel

for which 1−φ1z−· · ·−φpzp has a zero inside or on the unit circle, nor does it generate
fitted models with this property. From the point of view of second-order properties, this
represents no loss of generality (Section 3.1). If you are trying to enter an ARMA(p, q)
model manually, the simplest way to ensure that your model is causal is to set all the
autoregressive coefficients close to zero (e.g., .001). ITSMwill not accept a noncausal
model.

ITSM does not restrict models to be invertible. You can check whether or not the
current model is invertible by choosing Model>Specify and pressing the button
labeled Causal/Invertible in the resulting dialog box. If the model is noninvertible, i.e.,
if the moving-average polynomial 1 + θ1z+ · · · + θqzq has a zero inside or on the unit
circle, the message Non-invertible will appear beneath the box containing the
moving-average coefficients. (A noninvertible model can be converted to an invertible
model with the same autocovariance function by choosing Model>Switch to
invertible. If the model is already invertible, the program will tell you.)

E.6.2 Model ACF, PACF

ThemodelACF and PACF are plotted using Model>ACF/PACF>Model. If you wish
to change the maximum lag from the default value of 40, select Model>ACF/PACF>
Specify Lag and enter the required maximum lag. (It can be much larger than 40,
e.g., 10,000). The graph will then be modified, showing the correlations up to the
specified maximum lag.

If there is a data file open as well as a model in ITSM, the model ACF and PACF
can be compared with the sample ACF and PACF by pressing the third yellow button
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at the top of the ITSMwindow. The model correlations will then be plotted in red, with
the corresponding sample correlations shown in the same graph but plotted in green.

Figure E-11
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Figure E-12
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Example E.6.2. The sample and model ACF and PACF for the current model and transformed series
AIRPASS.TSM are shown in Figures E-11 and E-12. They are obtained by pressing
the third yellow button at the top of the ITSMwindow. The vertical lines represent the
model values, and the squares are the sample ACF/PACF. The graphs show that the
data and the model ACF both have large values at lag 12, while the sample and model
partial autocorrelation functions both tend to die away geometrically after the peak at
lag 12. The similarities between the graphs indicate that the model is capturing some
of the important features of the data.

�
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E.6.3 Model Representations

As indicated in Section 3.1, if {Xt} is a causal ARMA process, then it has an MA(∞)
representation

Xt =
∞∑
j=0

ψjZt−j, t = 0,±1,±2, . . . ,

where
∞∑
j=0

|ψj| < ∞ and ψ0 = 1.

Similarly, if {Xt} is an invertible ARMA process, then it has an AR(∞) represen-
tation

Zt =
∞∑
j=0

πjXt−j, t = 0,±1,±2, . . . ,

where
∑∞

j=0 |πj| < ∞ and π0 = 1.
For any specified causal ARMA model you can determine the coefficients in

these representations by selecting the option Model>AR/MA Infinity. (If the
model is not invertible, you will see only the MA(∞) coefficients, since the AR(∞)
representation does not exist in this case.)

Example E.6.3. The current subset MA(23) model for the transformed series AIRPASS.TSMdoes not
have an AR(∞) representation, since it is not invertible. However, we can replace the
model with an invertible one having the same autocovariance function by selecting
Model>Switch to Invertible. For this model we can then find an AR(∞)
representation by selecting Model>AR Infinity. This gives 50 coefficients,
the first 20 of which are shown below.

MA − Infinity AR − Infinity
j psi(j) pi(j)
0 1.00000 1.00000
1 −0.36251 0.36251
2 0.01163 0.11978
3 −0.26346 0.30267
4 −0.06924 0.27307
5 0.15484 −0.00272
6 −0.02380 0.05155
7 −0.06557 0.16727
8 −0.04487 0.10285
9 0.01921 0.01856
10 −0.00113 0.07947
11 0.01882 0.07000
12 −0.57008 0.58144
13 0.00617 0.41683
14 0.00695 0.23490
15 0.03188 0.37200
16 0.02778 0.38961
17 0.01417 0.10918
18 0.02502 0.08776
19 0.00958 0.22791

�
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E.6.4 Generating Realizations of a Random Series

ITSM can be used to generate realizations of a random time series defined by the
currently stored model.

To generate such a realization, select the option Model>Simulate, and you will
see the ARMA Simulation dialog box. You will be asked to specify the number of
observations required, the white noise variance (if you wish to change it from
the current value), and an integer-valued random number seed (by specifying and
recording this integer with up to nine digits you can reproduce the same realization
at a later date by reentering the same seed). You will also have the opportunity to add
a specified mean to the simulated ARMAvalues. If the current model has been fitted to
transformed data, then you can also choose to apply the inverse transformations to the
simulated ARMA to generate a simulated version of the original series. The default
distribution for the white noise is Gaussian. However, by pressing the button Change
noise distribution you can select from a variety of alternative distributions
or by checking the box Use Garch model for noise process you can
generate an ARMA process driven by GARCH noise. Finally, you can choose whether
the simulated data will overwrite the data set in the current project or whether they will
be used to create a new project. Once you are satisfied with your choices, click OK,
and the simulated series will be generated.

Example E.6.4. To generate a simulated realization of the series AIRPASS.TSM using the current
model and transformed data set, select the option Model>Simulate. The default
options in the dialog box are such as to generate a realization of the original series as
a new project, so it suffices to click OK. You will then see a graph of the simulated
series that should resemble the original series AIRPASS.TSM.

�

E.6.5 Spectral Properties

Spectral properties of both data and fitted ARMA models can also be computed and
plotted with the aid of ITSM. The spectral density of the model is determined
by selecting the option Spectrum>Model. Estimation of the spectral density
from observations of a stationary series can be carried out in two ways, either by
fitting an ARMA model as already described and computing the spectral density
of the fitted model (Section 4.4) or by computing the periodogram of the data
and smoothing (Section 4.2). The latter method is applied by selecting the option
Spectrum>Smoothed Periodogram. Examples of both approaches are given
in Chapter 4.

E.7 Multivariate Time Series

Observations {x1, . . . , xn} of an m-component time series must be stored as
an ASCII file with n rows and m columns, with at least one space between
entries in the same row. To open a multivariate series for analysis, select
File>Project>Open>Multivariate and click OK. Then double-click on
the file containing the data, and you will be asked to enter the number of columns (m)
in the data file. After doing this, click OK, and you will see graphs of each component
of the series, with the multivariate tool bar at the top of the ITSM screen. For examples
of the application of ITSM to the analysis of multivariate series, see Chapter 8.
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Accidental deaths (DEATHS.TSM), 2, 11, 27, 28,

96, 180, 183, 313, 315, 317
ACF. See Autocorrelation function (ACF)
AIC, 149, 152
AICC, 125, 134, 137, 142, 151, 153, 167, 248, 396
Airline passenger data (AIRPASS.TSM), 192, 278,

320, 386
All Ordinaries index, 228
All-star baseball games, 2, 7
Alternative hypothesis, 368
APPH.TSM, 256
APPI.TSM, 256
APPJ.TSM, 350
APPJK2.TSM, 256
APPK.TSM, 350
Arbitrage, 221, 222, 224
ARAR algorithm, 310–313

forecasting, 311–312
application of, 312–313

ARCH(1) process, 197–199
ARCH(p) process, 197, 224
ARCH.TSM, 200
AR(1) process, 15, 46, 54, 295

ACVF of, 46
causal, 47
confidence regions for coefficients, 142
estimation of mean, 51
estimation of missing value, 58, 282
observation driven model of, 295
plus noise, 69
prediction of, 57, 59
sample ACF of, 54
spectral density of, 103
state-space representation of, 261
with missing data, 58, 285, 287
with non-zero mean, 59–60

AR(2) process, 19, 76–77
ACVF of, 80–82

AR(p) process. See Autoregressive (AR(p)) process
ARIMA(1,1,0) process, 158

forecast of, 176–177
ARIMA process

definition, 158
forecasting, 173–177
seasonal (see Seasonal ARIMA models)

state-space representation of, 269
with missing observations, 280
with regression, 184, 203

ARIMA(p, d, q) process with (−.5 < d < .5). See
Fractionally integrated ARMA process

ARMA(1, 1) process, 48–50, 66, 76
ACVF of, 78
causal, 49, 66
invertible, 49, 76
noncausal, 49, 118
noninvertible, 49, 118
prediction of, 89
spectral density of, 116
state-space representation of, 261–262

ARMA(p, q) process
ACVF of, 78–82
coefficients in AR representation, 77
coefficients in MA representation, 76
causal, 75
definition, 74
estimation

Hannan-Rissanen, 137–139
innovations algorithm, 132–137
least squares, 141
maximum likelihood, 139–140

existence and uniqueness of, 75
invertible, 76
multivariate (see Multivariate ARMA processes)
order selection, 124–129, 151
prediction, 91–96
seasonal (see Seasonal ARIMA models)
spectral density of, 115
state-space representation of, 267–268
with mean μ, 74

Asymptotic relative efficiency, 129
Australian red wine sales (WINE.TSM), 2, 7, 18,

319, 320
Autocorrelation function (ACF)

definition, 16
sample ACF

of absolute values, 202–204, 396, 401
of squares, 200, 202–204, 401
approximate distribution of, 51

of MA(q), 79, 82
Autocovariance function (ACVF)

basic properties of, 39
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Autocovariance function (ACVF) (cont.)
characterization of, 41
definition, 13, 16, 45
nonnegative definite, 41
of ARMA processes, 78–87
of ARMA(1, 1) process, 80
of AR(2) process, 81
of MA(q) process, 79
of MA(1) process, 15, 42
sample, 59–60
spectral representation of, 101

Autofit
for ARMA fitting, 122, 142, 143, 167–169, 187,

203, 341, 392
for fractionally integrated ARMA, 341

Autoregressive integrated moving-average. See
ARIMA process

Autoregressive moving-average. See ARMA process
Autoregressive polynomial, 74–77, 143, 160, 162,

169, 170, 304, 346
Autoregressive (AR(p)) process, 74

estimation of parameters
Burg, 122
maximum likelihood, 142–143, 149
with missing observations, 284
Yule-Walker, 123–124
large-sample distributions, 124
confidence intervals, 131

one-step prediction of, 59
order selection, 134, 149, 150
minimum AICC model, 153
multivariate (see Multivariate AR models)
partial autocorrelation function of, 83
prediction of, 89
state-space representation, 266–267
subset models, 309, 311
unit roots in, 170
Yule-Walker equations, 124, 128

Autoregressive process of infinite order (AR(∞)),
236

B
Backward prediction errors, 130
Backward shift operator, 25, 44, 48, 74, 207, 311,

339
Bandwidth, 109
Bartlett’s formula, 53

AR(1), 54
independent white noise, 53
MA(1), 53
multivariate, 240

Bayesian state-space model, 289
BEER.TSM, 192
Best linear predictor, 40, 246–247
Beta function, 307
Beta-binomial distribution, 307
BIC criterion, 149, 152
Bilinear model, 338
Binary process, 7
Binomial distribution, 353
Bispectral density, 337
Bivariate normal distribution, 359–360
Bivariate time series

covariance matrix, 228

mean vector, 228
(weakly) stationary, 228

Box-Cox transformation, 165, 388, 389
Brownian motion, 213, 375–379
Burg’s algorithm, 129–132

C
CAR(1) process, 343–345

estimation of, 344
CARMA(p, q) process, 345

autocovariance function of, 347
mean of, 346, 347
with thresholds, 347

Cauchy criterion, 371–372
Causal

ARCH(1) process, 198, 199
ARMA process, 75
GARCH process, 208, 209
multivariate ARMA process, 244
time-invariant linear filter, 112

Chaotic deterministic sequence, 335–337
Checking for normality, 32
Chi-squared distribution, 31, 125, 353, 361
Classical decomposition, 20, 26, 29, 165, 389,

390
Cochran and Orcutt procedure, 186
Cointegration, 254–255
Cointegration vector, 254, 255
Compound Poisson process, 214–215
Conditional density, 289, 294, 299, 356
Conditional expectation, 40, 149, 285, 289, 357
Confidence interval, 367–368

large-sample confidence region, 368
Conjugate family of priors, 297
Consistent estimator, 108, 133, 237
Continuous distributions

chi-squared, 353
exponential, 352
gamma, 352–353
normal, 352
uniform, 352

Continuous spectrum, 101
Continuous-time ARMA process. See CARMA(p, q)

process
Continuous-time models, 212–220

CAR(1), 343
Covariance function, 13. See also Autocovariance

function (ACVF)
Covariance matrix, 376

factorization of, 358
properties of, 358
square root of, 358

Cumulant, 337, 350
kth-order, 337

D
Delay parameter, 325, 327, 331
Design matrix, 184–186
Deterministic, 67
Diagnostic checking, 144–147. See also Residuals
Difference operator

first-order, 25
with positive lag d, 28
with real lag d, 28, 343
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Differencing to generate stationary data, 12
at lag d, 28

Dirichlet kernel, 114
Discrete distributions

binomial, 353
negative binomial, 353–354, 361
Poisson, 353
uniform, 353

Discrete Fourier transform, 107
Discrete spectral average. See Spectral density

function
Distribution function, 351–355. See also Continuous

distributions; Discrete distributions
properties of, 351

Dow-Jones Utilities Index (DOWJ.TSM), 126–128,
131, 134–137, 143, 176, 177

Dow-Jones and All ordinaries Indices, (DJAO2.TSM,
DJAOPC2.TSM), 228–229, 249, 251–253

Durbin-Levinson algorithm, 60–62, 64, 65, 125, 126,
132, 133, 247

E
EGARCH (p, q) process, 205
Elementary function, 377–379
EM algorithm, 260, 285–288

Monte Carlo (MCEM), 293
Embedded discrete-time process, 344
Equivalent martingale measure, 223
Error probabilities, 389–390

type I, 369
type II, 369

Estimation of missing values
in an ARIMA process, 284
in an AR(p) process, 285
in a state-space model, 283

Estimation of the white noise variance
least squares, 140
maximum likelihood, 141
using Burg’s algorithm, 130
using the Hannan-Rissanen algorithm, 138
using the innovations algorithm, 136
using the Yule-Walker equations, 124

European call option, 221, 223
Expectation, 351–355
Exponential distribution, 352
Exponential family models, 296–303
Exponential smoothing, 21, 23, 316

F
FIGARCH (p, d, q) process, 209
Filter. See Linear filter
Financial data, 195–226
Fisher information matrix, 367
Forecasting, 12, 55–67, 147–148. See also Prediction
Forecasting ARIMA processes, 173–177

forecast function, 182–183
h-step predictor, 175

mean square error of, 174
forecast density, 289
forward prediction errors, 130

Fourier frequencies, 107, 109
Fourier indices, 11
Fractionally integrated ARMA process, 339

estimation of, 340

spectral density of, 340
Whittle likelihood approximation, 340

Fractionally integrated white noise, 339
autocovariance of, 339
variance of, 339

Frequency domain, 97, 236

G
Gamma distribution, 206, 218, 295, 352
Gamma function, 339, 352
GARCH(p, q) process, 200

ARMA model with GARCH noise, 203–204
fitting GARCH models, 201–203
Gaussian-driven, 203
generalizations, 203
regression with GARCH noise, 203
t−driven, 203

Gaussian likelihood
in time series context, 367
of a CAR(1) process, 343–344
of a multivariate AR process, 248
of an ARMA(p, q) process, 140

with missing observations, 281–283
of GARCH model, 340
of regression with ARMA errors, 186, 187

Gaussian linear process, 334, 335, 337
Gaussian time series, 40, 42, 139, 242, 361
Gauss-Markov theorem, 365, 367
Generalized distribution function, 101
Generalized error distribution (GED), 206
Generalized least squares (GLS) estimation, 184–186
Generalized inverse, 184, 271, 304
Generalized state-space models

Bayesian, 289
filtering, 289, 290
forecast density, 289
observation-driven, 294–295
parameter-driven, 288–294
prediction, 289, 290

Geometric Brownian motion (GBM), 195, 196,
215–217, 381, 382

Gibbs phenomenon, 114
Goals scored by England against Scotland, 299–302
Goodness of fit based on ACF, 18–19. See also Tests

of randomness

H
Hannan-Rissanen algorithm, 122, 136, 137–139
Harmonic regression, 10–12
Hessian matrix, 142, 187
Hidden process, 289
Holt-Winters algorithm, 314–317

seasonal, 317–318
Hypothesis testing, 368–370

large-sample tests based on confidence regions,
369–370

uniformly most powerful test, 369

I
IARCH(∞) process, 209
IGARCH(p, q) process, 208
Independent random variables, 30, 36, 214
Identification techniques, 163–169

for ARMA processes, 164
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Identification techniques (cont.)
for AR(p) processes, 142
for MA(q) processes, 153
for seasonal ARIMA processes, 177

IGARCH(p, q) process, 208, 209
iid noise, 6–7, 14

sample ACF of, 53
multivariate, 235

Innovations, 62, 271
Innovations algorithm, 62–65, 132–137

fitted innovations MA(m) model, 133
multivariate, 247

Input, 45, 112, 333
Integrated volatility, 217, 218, 220, 226
Intervention analysis, 331–334
Invertible

ARMA process, 76
multivariate ARMA process, 244

Investment strategy, 221, 222, 224
Itô calculus, 373

Itô integral, 343, 375–379
Itô process, 379–380
Itô’s formula, 380
Itô stochastic differential equation, 381–383

ITSM, 27–33, 37, 122, 125–127, 165, 327, 329,
385–407

J
Joint distributions of a time series, 6
Joint distribution of a random vector, 355

K
Kalman recursions

filtering, 271, 274
prediction, 271

h−step, 272–275
smoothing, 271, 275

Kullback-Leibler discrepancy, 151
Kullback-Leibler index, 151, 152

L
Lake Huron (LAKE.TSM), 9–10, 18–19, 54, 189,

191
Latent process, 289
Large-sample tests based on confidence regions,

369–370
Least squares estimation

for ARMA processes, 141
for regression model, 186
for transfer function models, 326
of trend, 8

Lévy process, 195, 212–218, 347–350, 375–377
Lévy-Itô decomposition, 214
Lévy-Khinchin representation, 374
Lévy market model (LMM), 216
Lévy measure, 374

Likelihood function, 277, 292, 366. See also
Gaussian likelihood

Linear combination of sinusoids, 101–103
Linear difference equations, 47, 175
Linear filter, 36, 45, 48, 74

input, 45
low-pass, 23, 114

moving-average, 22, 36
output, 45
simple moving-average, 112–114

Linear process, 44, 335
ACVF of, 46
Gaussian, 334
multivariate, 235

Linear regression. See Regression
Local level model, 264
Local linear trend model, 264, 265, 304, 315
Log asset price, 195, 197, 212, 216
Log return, 195–197, 209, 219
Logistic equation, 335, 336
Lognormal SV process, 210, 211–212, 274
Long memory, 207–209, 310, 323
Long-memory model, 338–342

M
MA(1) process

ACF of, 42
estimation of missing values, 71
moment estimation, 128–129
noninvertible, 85, 95
order selection, 128–129
PACF of, 84
sample ACF of, 53
spectral density of, 105–106
state-space representation of, 273

MA(q). See Moving average (MA(q)) process
MA(∞), 44

multivariate, 235
Market price of risk, 224
Martingale difference sequence, 334
Maximum likelihood estimation, 366–367

ARMA processes, 140
large-sample distribution of, 142
confidence regions for, 142–144

Mean
of a multivariate time series, 236

estimation of, 236–243
of a random variable, 352, 354
of a random vector, 357
estimation of, 50
sample, 50

large-sample properties of, 51, 236
Mean square convergence, 65, 371–372

properties of, 372, 378
Measurement error, 84–86, 172
Memory shortening, 309, 310
Method of moments estimation, 85, 129
Minimum AICC AR model, 147, 256, 396,

402
Mink trappings (APPH.TSM), 256
Missing values in ARMA processes

estimation of, 283–285
likelihood calculation with, 281–283

Mixture distribution, 354
Monte Carlo EM algorithm (MCEM), 293
Moving average (MA(q)) process, 43

ACF of, 79
sample, 82

ACVF of, 79
estimation

confidence intervals, 143
Hannan-Rissanen, 137
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innovations, 133
maximum likelihood, 140, 142

order selection, 133, 134
partial autocorrelation of, 83
unit roots in, 171–173

Multivariate AR process
estimation, 247–249

Burg’s algorithm, 248
maximum likelihood, 248
Whittle’s algorithm, 248

forecasting, 250–254
error covariance matrix of prediction, 251

Multivariate ARMA process, 243–246
causal, 244
covariance matrix function of, 245–246
estimation

maximum likelihood, 248
invertible, 244
prediction, 246–247

error covariance matrix of prediction, 252
Multivariate innovations algorithm, 247
Multivariate normal distribution

bivariate, 359–360
conditional distribution, 360
conditional expectation, 357
density function, 356
definition, 358
singular, 359
standardized, 359

Multivariate time series, 223
covariance matrices of, 228, 233, 235
mean vectors of, 228, 233, 235
second-order properties of, 232–236
stationary, 233

Multivariate white noise, 227, 235, 243
Muskrat trappings (APPI.TSM), 256

N
Negative binomial distribution, 292, 353, 361
NILE.TSM, 340–342
NOISE.TSM, 326, 333
Non-anticipating integrand, 376
Nonlinear models, 334–338
Nonnegative definite matrix, 357, 358
Nonnegative definite function, 41
Normal distribution, 352, 355
Normal equations, 363, 364
Null hypothesis, 34, 147, 170, 172, 337, 368,

369

O
Observation equation, 260

of CARMA(p, q) model, 345
Ordinary least squares (OLS) estimators, 170, 184,

185, 363
One-step predictors, 60, 63, 88, 136, 140, 149, 174,

252, 271, 280, 281, 302
Order selection, 124, 133, 137, 141, 149–153

AIC, 149, 152
AICC, 149, 151–153
BIC, 149, 152
consistent, 152
efficient, 152
FPE, 149–150

Ornstein-Uhlenbeck process, 217, 218, 220, 225, 343
Ornstein-Uhlenbeck SV model, 219

Orthogonal increment process, 103
Orthonormal set, 107
Overdifferencing, 169, 171
Overdispersed, 299
Overshorts (OSHORTS.TSM), 84–86, 128, 147, 148,

172, 187–188
structural model for, 85

P
Partial autocorrelation function (PACF), 62, 83–84

estimation of, 85
of an AR(p) process, 83
of an MA(1) process, 84
sample, 83, 84

Periodogram, 106–111, 208, 340
approximate distribution of, 108

Point estimate, 367
Poisson distribution, 296, 299, 300, 355

Poisson exponential family model, 296
Poisson process, 195, 213–215, 217, 351, 374
Polynomial fitting, 24–25
Population of USA (USPOP.TSM), 4, 8–9, 25–26
Portmanteau test for residuals. See Tests of

randomness
Posterior distribution, 289, 294, 297, 298, 306,

307
Power function, 369
Power steady model, 298, 299
Prediction of stationary processes. See also Recursive

prediction
AR(p) processes, 89
ARIMA processes, 173–177
ARMA processes, 87–94
based on infinite past, 65
best linear predictor, 40
Gaussian processes, 94

prediction bounds, 94
large-sample approximations, 93
MA(q) processes, 89
multivariate AR processes, 250–254
one-step predictors, 57

mean squared error of, 92
seasonal ARIMA processes, 182–183

Prediction operator, 58–60
properties of, 59

Preliminary transformations, 12, 20, 163
Prewhitening, 239, 324
Prior distribution, 289
Probability density function (pdf), 354
Probability generating function, 361
Probability mass function (pmf), 354
Purely nondeterministic, 67, 334

Q
q−dependent, 43
q-correlated, 43, 44
qq plot, 32, 147, 202–203, 401–402

R
R and S arrays, 157
Random noise component, 20, 389
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Random variable
continuous, 353, 354
discrete, 354, 355

Randomly varying trend and seasonality with noise,
266, 317

Random vector, 355–358
covariance matrix of, 357
joint distribution of, 355
mean of, 357
probability density of, 356

Random walk, 7, 14
simple symmetric, 7, 14
with noise, 263, 272, 278, 299

Rational spectral density. See Spectral density
function

Realization of a time series, 6, 409
Realized volatility, 217
Recursive prediction

Durbin-Levinson algorithm, 60, 247
Innovations algorithm, 64–65
Kalman prediction (see Kalman recursions)
multivariate processes

Durbin-Levinson algorithm, 247
innovations algorithm, 247

Regression
with ARMA errors, 184–191

best linear unbiased estimator, 185
Cochrane and Orcutt procedure, 185,

186
GLS estimation, 185
OLS estimation, 184

Rejection region, 368, 369
RES.TSM, 333, 334
Residuals, 30, 144

check for normality, 33, 147
graph of, 145
rescaled, 145
sample ACF of, 146
tests of randomness for, 146–147

Risk-neutral, 224

S
Sales with leading indicator (LS2.TSM,

SALES.TSM, LEAD.TSM), 230–
232, 242–243, 249–250, 253–254,
326–327, 329–330

Sample
autocorrelation function, 16–18

MA(q), 82
of residuals, 146

autocovariance function, 16
covariance matrix, 16
mean, 16

large-sample properties of, 50
multivariate, 228

partial autocorrelation, 83
SARIMA. See Seasonal ARIMA process
Seasonal adjustment, 5
Seasonal ARIMA process, 177–183

forecasting, 182–183
mean squared error of, 183

maximum likelihood estimation, 180, 181
Seasonal component, 20

estimation of, 21–25
method S1, 26–27

elimination of, 28
method S2, 28–30

Seat-belt legislation (SBL.TSM, SBL2.TSM),
189–191, 333–334

Second-order properties, 6
in frequency domain, 236

Self-financing condition, 221
Short memory, 313, 339
SIGNAL.TSM, 3, 33
Signal detection, 3
Significance level, 153, 369, 402
Size of a test, 369
Smoothing

by elimination of high-frequency components,
23–24

with a moving average filter, 21–23
exponential, 21, 23, 314, 316, 319
the periodogram (see Spectral density estimation)
using a simple moving average, 112

Spectral density estimation
discrete spectral average, 109

large-sample properties of, 110
rational, 117

Spectral density function, 98–106
characterization of, 99
of an ARMA(1, 1), 116
of an ARMA process, 115
of an AR(1), 103–105
of an AR(2), 116
of an MA(1), 105–106
of white noise, 103
properties of, 98
rational, 115

Spectral density matrix function, 236
Spectral distribution function, 101–103, 117
Spectral representation

of an autocovariance function, 101
of a covariance matrix function, 233
of a stationary multivariate time series, 233
of a stationary time series, 97

Spencer’s 15-point moving average, 22–23, 36
Spot volatility, 217
State equation, 260

of CARMA(p, q) model, 345
stable, 262, 267

State-space model, 259–307
estimation for, 275–280
stable, 262
stationary, 262
with missing observations, 280–285

State-space representation, 261
causal AR(p), 266–267
causal ARMA(p, q), 267–268
ARIMA(p, d, q), 268–269

Stationarity
multivariate, 227
strict, 13, 43, 361
weak, 13, 361

Steady-state solution, 273, 274, 305, 315
Stochastic differential equation, 196, 215, 218, 343,

345, 348, 383–385
first-order, 343
pth-order, 345

Stochastic volatility model, 197, 209–212, 217–220,
226, 274

Stock market indices (STOCK7.TSM), 225, 257
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Strictly stationary series, 13, 43
properties of, 43

Strike price, 221
Strike time, 221
Strikes in the U.S.A. (STRIKES.TSM), 4, 22, 36,

96
Structural time series models, 85, 263

level model, 263–265
local linear trend model, 264, 265, 315
randomly varying trend and seasonality

with noise, 266, 278
estimation of, 275–280

seasonal series with noise, 265
Stylized features, 196, 204
Subordinator, 217
Sunspot numbers (SUNSPOTS.TSM), 70, 86–87,

110–111, 117, 153, 203, 204, 335

T
Testing for the independence of two stationary time

series, 239–240
Test for normality, 33, 147, 400
Tests of randomness

based on sample ACF, 30
based on turning points, 31–33, 146
difference-sign test, 32, 146
Jarque-Bera normality test, 33, 146
minimum AICC AR model, 147
portmanteau tests

Ljung-Box, 31, 146, 402
McLeod-Li, 31, 146, 402

rank test, 32, 146
Third-order central moment, 337
Third-order cumulant function, 337, 350

of linear process, 337, 350
Threshold model, 338

AR(p), 338
Time domain, 97, 248
Time-invariant linear filter (TLF), 111–115

causal, 112
transfer function, 113

Time series, 6
continuous-time, 1
discrete-time, 1
Gaussian, 40, 42, 361

Time series model, 6
Time series of counts, 292–294
Transfer function, 113–115
Transfer function model, 323–330

estimation of, 324–326
prediction of, 327–330

Transformations, 20, 163–164, 388
variance-stabilizing, 165

Tree-ring widths (TRINGS.TSM), 351
Trend component, 7–10, 20

elimination of
in absence of seasonality, 21–25
by differencing, 25–26

estimation of
by elimination of high-frequency components,

23
by exponential smoothing, 23
by least squares, 10
by polynomial fitting, 24–25
by smoothing with a moving average, 21, 26

U
Uniform distribution, 352, 353

discrete, 353–354
Uniformly most powerful (UMP) test, 369
Unit roots

augmented Dickey-Fuller test, 170
Dickey-Fuller test, 170
in autoregression, 169–171
in moving-averages, 171–173
likelihood ratio test, 172
locally best invariant unbiased (LBIU) test, 173

V
Variance, 352, 354
Volatility, 196, 209, 216, 349

W
Weight function, 109, 110
White noise, 14

multivariate, 235
spectral density of, 103

Whittle approximation to likelihood, 340
Wold decomposition, 44, 67, 334

Y
Yule-Walker estimation, 86, 123–124. See also

Autoregressive process and multivariate
AR process

for q > 0, 128–129

Z
Zoom buttons, 388
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